St. Cloud State University

Outlook 2001 for the Macintosh

Introduction to Outlook
  E-Mail
  Calendar
  Contacts
  Tasks
  Public Folders

December 2001

(last revised 12-21-2001)
Microsoft Outlook 2001 for the Macintosh

This manual was written for the 2001 version of Outlook for the Macintosh. All information relates to that version as of 12-18-2001.
This manual will also be made available electronically via the Web and/or via Exchange Public Folders. Revisions will be made to the electronic version as necessary.

This manual is simply to serve as a guide to help users become familiar and comfortable with the Outlook/Exchange environment. It is by no means comprehensive. Online help is available from within Outlook. The online help provides searchable topics and hyperlinks that will aid users who are looking for more specific information, and for topics that are not included in this manual.

The manual was created by the SCSU Center for Information Systems with input from staff at the SCSU Helpdesk and SCSU Computing and Technology User Services.

Special thanks to
Dan Michaels
Randy Kolb
Gordie Schmitt
for providing feedback and suggestions.
TABLE OF CONTENTS

Terminology in Outlook/Exchange Environment................................................................. 1
Technical Support .................................................................................................................. 2
Terminology used in this Manual .......................................................................................... 3
Server Space Quotas ............................................................................................................. 7
E-MAIL ................................................................................................................................. 15

Reading Messages ............................................................................................................... 15
  Handling Messages as They Are Read ................................................................................ 17
  Change Options for Reading Mail ...................................................................................... 30
  Responding to a Voting Button Message ......................................................................... 31

Sending a Message .............................................................................................................. 33
  The Global Address List .................................................................................................... 34
  Selecting a Name from a Different List .............................................................................. 35
  Auto Addressing ............................................................................................................... 36
  Signatures ......................................................................................................................... 40
  Insert a File in a Message ................................................................................................. 43
  Options for Sending Individual Messages ....................................................................... 49

Out of Office Assistant ........................................................................................................ 56
Default E-Mail Preferences ................................................................................................. 58

Address Book Descriptions ................................................................................................. 63
  Global Address List .......................................................................................................... 63
  SCSU Campus Address Lists ............................................................................................ 63
  Contacts Folder .................................................................................................................. 63

CONTACTS ............................................................................................................................ 64
  Creating a New Contact ..................................................................................................... 64
  Generating a Map from a Contact Entry .......................................................................... 71
  Distribution Lists ............................................................................................................. 73

Calendar ............................................................................................................................... 76
  Types of Calendar Entries ................................................................................................. 78
  Inviting People to a Meeting ......................................................................................... 86

Sharing Calendars .............................................................................................................. 99
  Granting Permission for Someone to View and/or Update Your Calendar ....................... 99
  Accessing Another Person’s Calendar .......................................................................... 103

DELEGATE ACCESS ............................................................................................................ 106
  Sending Messages on Behalf of Another Person .............................................................. 107
  Requesting a Meeting on Behalf of Another Person ....................................................... 108

TASKS .................................................................................................................................. 109

OWA Outlook Web Access ................................................................................................. 113
  Changing the Password ................................................................................................. 128
  Closing OWA .................................................................................................................. 131

PUBLIC FOLDERS .............................................................................................................. 133
  SCSU-Announce and SCSU-Discuss Folders ................................................................. 134

Some Notes about Outlook 2001 for the Mac ............................................................... 137
  Retaining Original E-mail Address in Forwarded Messages ......................................... 137
  Voting Buttons ................................................................................................................ 138
  PDAs and Synching to Outlook ....................................................................................... 138

Keyboard Shortcuts in Outlook ......................................................................................... 139

Outline of Topics in Manual ............................................................................................. i
TERMINOLOGY IN OUTLOOK/EXCHANGE ENVIRONMENT

**Exchange** is the term used for the server environment that provides storage for your e-mail, contacts (address book) and your calendar entries. This server environment could be compared to the TIGGER server, which provided e-mail services. Your e-mail was received by TIGGER and distributed to your inbox via whatever software you used (Eudora, Pegasus, Netscape, etc.). The previous system typically removed your e-mail from the server once you read it, and transferred it to your hard disk on your local computer.

In the Exchange environment, all your e-mail, calendar entries, and contact (address book) information stays on the server. This enables you to access your account from remote sites and still see all your e-mail (both unread and previously read messages) as well as your calendar and contact entries. You are able to use a Web browser at any site to gain access to your account. You are able to read and send e-mail and view and update your calendar entries via the Web browser interface. Individual customsettings that you change are typically stored on your local hard drive (background color for the calendar, etc.)

**Outlook** is the name of the e-mail software that is installed on your individual computer. It is also referred to as the desktop client. It enables you to use the full features provided by the Exchange server environment. Using Outlook, you have access to a Global Address List, an e-mail directory for the entire campus—faculty, staff, administrators and students. It enables you to maintain an electronic calendar that you may access from your office as well as from other remote sites. It provides access to your own personal contacts (address book), which stores your individual e-mail addresses for off campus people and any distribution lists you create. Outlook has advanced features that enable users on the same Exchange server to plan meetings using the electronic calendar and e-mail components together.

**Outlook Web Access** (aka OWA) is the Web browser interface that enables you to access your e-mail, calendar, and contacts from any computer that has a connection to the Internet and has a Web browser installed. Internet Explorer is the preferred browser, but you may use Netscape as well. The OWA has many, but not all, of the features available from the desktop client. You access your account by going to a web address: [http://huskynet.stcloudstate.edu](http://huskynet.stcloudstate.edu) and typing in your user ID and password.

**HuskyNet** is the term used for your NEW account in the Exchange server environment which replaces the e-mail service previously provided by the TIGGER and/or CONDOR server. This new account is designed to enable you to not only access your e-mail, but to provide you with access to other SCSU resources as well, including: your own personal file space, your own personal Web folders and other resources to be provided in the future. The concept is to have one ID and password that enable you to perform any tasks required for your job (except the MnSCU interface, which will always be a separate account with its own User ID and password).
TECHNICAL SUPPORT

OUTLOOK INSTALLATION & TROUBLESHOOTING PROBLEMS IN OUTLOOK

Your college or department technical support staff can install Outlook for you. If your department doesn’t have its own technical support, you may call the Helpdesk at 255-2077.

QUESTIONS ABOUT FEATURES AND USE OF OUTLOOK

Questions about features and use of Outlook can be referred to the Helpdesk at 255-2077.

ONLINE HELP

Outlook has extensive online help that you can access from the Help menu when Outlook is running.

Other help is offered at some SCSU web pages.

COMPARISON OF FEATURES ON MACINTOSH, WINDOWS AND OWA VERSIONS

http://www.stcloudstate.edu/help/faqs/outlookfeatures.html

OWA (OUTLOOK WEB ACCESS)

http://www.stcloudstate.edu/ctus/online/exchange/

HUSKYNET FILE SPACE AND WEB SPACE

http://www.stcloudstate.edu/ctus/online/exchange/network_storage.html

ACQUIRING AND CONFIGURING OUTLOOK

http://www.stcloudstate.edu/help/faqs/exchangeconfig.html
TERMINOLOGY USED IN THIS MANUAL

SPINNER BUTTONS
These are triangle buttons at the end of a field. Click on the button to display a list of possible choices. Then click on one of the items from the list.

This spinner button appears in the Calendar’s New Appointment window, allowing you to select the way you want the time displayed on your calendar. The choices are Busy, Free, Out of Office and Tentativ.

CHECKBOX
These are square graphic images that allows you to place a checkmark in them (by clicking once in the box) to turn a feature on. To turn the feature off, click once in the box to remove the checkmark. This blank checkbox indicates the Reminder feature is not turned on.

Some checkboxes appear in groups. Note that you may check more than one feature in a group of checkboxes.

RADIO BUTTONS
These are round graphic images that allow you to click in them to select them. Selected radio buttons are indicated by a large black dot in the center. With radio buttons, you may only select one option from the grouping of buttons. (By contrast, in a grouping of checkboxes, you may select multiple options from the grouping.) In the example below, the radio buttons for the way you want to navigate in your Inbox after moving or deleting an open item are listed. You may select only ONE option.

TOOLBAR BUTTONS
These are graphic images that provide shortcuts to perform functions. The buttons may include text, or appear with only a graphic image. Typically, if you point your mouse to a button, a tip appears to describe what the button does. Click once on a button to make it perform a function. The toolbar buttons below are for forwarding a message, printing, moving the selected item. When the mouse button is positioned over the Move button, the toolbar tip appears, indicating that this button is for moving an item.
**KEYBOARD COMMANDS**

Keyboard commands are shortcuts that perform actions when you press specific key combinations on the keyboard. Frequently, the *Open Apple* button is used in conjunction with another key. The keyboard command is written with this symbol, which also appears on the *Open Apple* key:  Other keys often used in keyboard commands are the *shift*, *control* and *alt/option* keys.

**DIALOG WINDOW**

A dialog window will come up when you try to perform a function that requires information from you. An example would be when you select the *Rules* feature from the *Tools* menu. The *Rules*… feature on the menu is followed by three dots, which always means you will be taken to a dialog window. At the dialog window, you must respond by clicking checkboxes or radio buttons, or entering information to indicate your particular choices. If you decide you don’t want to go through with the changes you’ve made, click on the *Cancel* button. To confirm the changes and make them take effect, click on the *OK* button.

![Dialog Window Example](image)

**POP-UP MENU**

When you hold down the *Control* key and click on an item, a pop-up menu will appear, listing options available to you that relate to the item you clicked on. An example would be Control + Click on the *Inbox* icon on the *Outlook Bar*. This pop-up menu will appear:

![Pop-up Menu Example](image)
**DROP-DOWN LIST**
A drop-down list will be displayed when you click on the drop-down (triangle or arrow) button. You may select an option from the list. An example is the drop-down button beside the *New* button on the *Outlook Toolbar*.

![New Button](image)

When you click on the drop-down button, you will see a list of new things you can create. Click on the item you want to create.

![Dropdown List](image)

**ICONS**
Icons are graphic images usually accompanied by a text label. Click on the icon (graphic image) rather than on the text label.

![Inbox Icon](image)
**EXPAND/Collapse Buttons**

The *Expand/Collapse* buttons are triangle buttons that allow you to see more or fewer levels of items in a list that has more than one level. An example is the folder list. The main level includes the *Mailbox* and *Public Folders*. There are *Expand* buttons beside each of these folders. If you click on the *Expand* button, you will see a list of the next level of items under that level.

The *Expand* button has been clicked for *Mailbox* and *Contacts*, displaying items that are in the next level. Once you click on an *Expand* button, it changes to a *Collapse* button, so you can click on it to collapse that expanded level and remove it from view.

*Expand* buttons will only appear beside items that have another level beneath them. *Collapse* buttons will only appear when an item has been expanded.
SERVER SPACE QUOTAS

EXCHANGE MAILBOX SPACE QUOTA

55 Megabytes for Faculty, Staff and Administrators

Your Exchange Mailbox includes all the items in your Inbox (and any subfolders you’ve created under the Inbox), Sent Items, Drafts and Deleted Items folders, as well as all appointments on your Calendar and tasks in your Tasks folder. Any mail messages that have file attachments also use up your allotted space quota—this includes messages that you receive and messages that you send (a copy of every message you send is stored in the Sent Items folder). You may want to review your Sent Items folder periodically to delete any unneeded items. The Deleted Items folder should also be reviewed periodically and either completely emptied, or at least scanned for individual items that may be permanently deleted.

ATTACHMENT SIZE LIMIT

You may send and receive individual file attachments of up to 5.5 Megabytes in size. However, if the messages pass through other mail servers, they will be further restricted by size limitations on those servers. If you send from one person to another on SCSU’s Exchange server, the limit is 5.5 Mb, but if you send an attachment to another person who is not on this Exchange server, you will be limited to whatever size attachment is allowed on that person’s server.

FILESPACE AND WEBSPACE QUOTA

100 Megabytes for Faculty, Staff and Administrators

This is a combined quota, so you share the 100 Mb of space between your files and your web pages. This filespace and webspace is in addition to the 55 Megabytes you have for your Mailbox. The combined size of all your files and web pages cannot exceed 100 Megabytes.

CHECKING AMOUNT OF SPACE USED

To see how much space you have used for your Mailbox, display the Folder List (from View menu, click on Folder List). Click on the Mailbox icon. Then hold down the Control key and click on a blank spot on the Folder Bar. From the pop-up menu, click on Show Folder Size.

You will see the size of your entire Mailbox folder. Click on individual folders to see their sizes.

EXCEEDING YOUR SPACE QUOTA

You will receive an e-mail warning if you exceed your allotted quota for either the mailbox or the filespace and webspace. This is a good time to review your Inbox, Sent Items and Deleted Items folders and your personal files to delete any unneeded messages or files.
OUTLOOK VISUAL ELEMENTS

Outlook is a comprehensive messaging and scheduling software application that includes several components: **E-mail, Calendar, Contacts** (address entries and distribution lists), **Tasks**, **Notes** and a **Journal**. The **E-mail** components include: **Inbox, Deleted Items, Drafts, Outbox** and **Sent Items**.

The **Outlook** main windows look very much like other windows, with a **Menu** bar, **Title** bar, **Toolbar** and **Scroll** bars. Additional items include the **Outlook Bar**, seen here as a vertical bar on the far left, and the **Folder List**, shown on the next page. There is also a **Folder Bar** that displays the name of the currently selected component—this example shows the **Inbox** displayed.

The **Outlook Bar** displays icons for the components of your account: **Inbox, Calendar**, etc. You simply click on an icon to display that component.
**Folder List**

The *Folder List* can be displayed by clicking on the View menu and selecting *Folder List*, or by clicking on the triangle button on the *Folder Bar*:

Folder names that appear in boldface have unread messages in them. The number in parentheses indicates how many unread messages are in that folder.

The *Folder List* displays the **Outbox**, which is not shown on the *Outlook Bar*. The *Folder List* also allows you to collapse and expand folders to see subfolders. In this example, there are two subfolders under the **Inbox**, which has been expanded. The **Public Folders** has not been expanded. To expand and collapse folders, use the triangle button to the left of the folder icon.

It may be redundant to display both the *Folder List* and the *Outlook Bar*. To display or to remove either from view, use the View menu.
OUTLOOK WINDOW

Menu Bar--lists categories of features that may be used with Outlook. Depending upon which component is currently displayed (Inbox, Calendar, etc.) the features available under particular menus (Actions, etc.) will change.

Title Bar--indicates which component is currently active--in this example, it's the Inbox. Also displays the name of the application that is currently active—in this example, of course, it’s Outlook.

Toolbar--displays buttons that can be used with the component that is currently active. The toolbar is context sensitive, so the buttons will change based on which component is displayed (Inbox, Calendar, etc.)

Folder Bar--displays the name of the component that is currently active along with a triangle button. Click on the triangle button to display the Folder List.

New Button—the image on the New button (on the toolbar) will change depending upon which component is displayed. If the Inbox is displayed, the New button will display an envelope, paper and pencil, and if you click on it, will open a New Message window. If the Calendar is displayed, the New button will display a calendar icon. If the button is clicked, a New Appointment window will open. However, if you click on the narrow triangle button beside the New button, you will get a drop-down menu that allows you to select ANY new thing you want.

New Message   New Appointment    New Anything

Page 10
**E-MAIL—VIEWING THE Inbox**

The **Inbox** has many icons to alert you to specific types of messages (urgent, forwarded, attachment, etc.) These icons will show up under the header categories shown at the top of the **Inbox**. The categories are: Flag, Importance, Message Icon, Attachment, From, Subject, Received, and Size.

You may always use these header buttons to do a quick sort by category. Click on a header button (such as "From") and the messages will be sorted in **ascending** order by that category. Click on the same button again and the messages will be sorted in **descending** order.

This example shows seven messages in the **Inbox**.

Three display an opened envelope **Message Icon**, indicating that those messages have been read.

One displays a closed envelope, indicating that the message has not been read.

One displays a special ticket icon indicating the message is from the System Administrator (usually to inform you that a message you tried to send could not be delivered).

One displays a green right arrow, indicating that you have forwarded the message.

One displays a blue left arrow, indicating you have replied to the message.

Three display a paper clip, indicating the message has a file attached.

One displays a red arrow pointing up, indicating the message was tagged as high priority by the sender.

Two messages display a white flag, indicating the message was flagged (often for future follow-up) and the follow-up has been completed. A red flag indicates that follow-up (or some other type of special attention) has not yet been completed.

Another visual cue is that a message displayed in **bold** typeface has not been read. On the right side of the **Folder Bar** a total **count** of messages in the Inbox is displayed, with a breakdown of how many are unread. (To display the selected folder’s **size**, hold down the **Control** key and click on a blank spot on the **Folder Bar**. From the pop-up menu, click on **Show Folder Size**.)

Of course, this manual is printed in black and white, so you will need to open Outlook on your computer to see the items in their proper color displays as described throughout the manual.
**INBOX VISUAL INDICATORS**

The four headings indicated by icons in the *Inbox* are for **Flag**, **Importance**, **Message**, and **Attachment**.

The **flag** column will be blank (item not flagged for follow up), display a red flag (flagged item that has not yet been completed) or a white flag (flagged item that has been completed).

The **importance** column will be blank (normal priority), display a red up arrow (high priority), or a blue down arrow (low priority).

The **Mail** column displays many different icons:
- **Closed envelope**: unread message
- **Blue ↓**: message of low importance
- **Door with green arrow**: recipient is out of the office for extended period
- **Ticket with green opened envelope**: Read receipt, message has been read by recipient
- **Blue Left Arrow**: message has been replied to
- **Two Heads and red X**: invitation declined
- **Two Heads and yellow minus**: invitation tentatively accepted
- **Two Heads and green checkmark**: invitation accepted
- **Green Right Arrow**: message has been forwarded
- **Opened Envelope**: message has been read
- **Red ↑Up Arrow**: message of high importance
- **Two Heads and Envelope**: meeting invitation

The **Attachment** column will display a paper clip if a file is attached.

**Ticket with green arrow and red bar**: message was undeliverable

The **red** flag appears beside messages that you have flagged for follow up.
SORTING MAIL IN THE INBOX

The Inbox has several headings listed above the message lines. They are: **Flag, Importance, Message, Attachment, From, Subject, Received** and **Size**. By default, your mail messages in your Inbox are sorted by date **received**, with the most recently received messages appearing at the top of the list. If you want to sort by any one of the headings listed above, click on the heading. The messages will be sorted by that heading. If you click on that heading again, the messages will be sorted in reverse order by that heading. Note that when you sort by Subject, the FW:, READ:, etc., prefixes are not included in the alphabetization.

Note that these messages are sorted by the **subject** heading, but the FW: prefix is not included in the fourth message—instead it is alphabetized by the “Athletics…” that follows the FW: prefix.

Note that these messages are sorted by the **Flag** heading. Within this heading, they are sorted by date. This is a useful way to bring your flagged messages to your attention.
About Sorting Mail

You can sort by any heading, but sorting is not permanent. You can resort at any time. If you sort by the **From** heading, you can type a few letters to jump to a particular person. For instance, if you click on the **From** heading and want to see messages that are from someone named Jon Carter, type _car_ on your keyboard. Messages from anyone whose name begins with _car_ will appear at the top of the list. Note that the **From** heading displays some names with the first name first and some with the last name first. This simply depends upon how the sender identifies him or herself.

This **Inbox** was sorted by the **From** heading and then _kar_ was typed on the keyboard. The selected message jumped to the first message that is from someone whose name begins with _kar_. Note that the **Inbox** simply scrolled to that part of the list—the scroll bar at the right is not at the top, so you know that you are not at the top of the **Inbox**. Also note that any messages from the same person are further sorted by date and time received.
E-MAIL

READING MESSAGES

Mail is delivered to your Inbox. It stays there (and resides on the Exchange server--it is not saved on your hard drive) until you delete it or move it to a different folder.

There are two ways to read messages: In a separate window or in the Preview Pane.

READING A MESSAGE IN A SEPARATE WINDOW

Double-click on the message line and the message will open in a separate window. From that window, you can deal with the message by:

- **Replying** to it (to the individual sender or to the sender and all recipients),
- **Forwarding** it,
- **Printing** it,
- **Moving** it to a folder,
- **Deleting** it,
- **Flagging** it,
- **Moving** to the next or previous message in the Inbox.

Buttons to perform these actions are on the toolbar in the message window. Notice that these buttons appearing on the toolbar are all relative to what you can do with a message you are reading. This is the context-sensitive toolbar feature.

To keep the separate message window open, and continue to read more messages from the Inbox, click on the Up or Down arrow buttons on the toolbar to move to the Next or Previous message. When finished viewing messages, close the separate message window and you will return to the Inbox display.
READING A MESSAGE BY USING THE PREVIEW PANE

To read a message via the Preview Pane, click on the View menu and click on Preview Pane. The Inbox window will split into two panes—the upper pane will display the message info and the lower pane will display the contents of one message at a time (whichever message is currently selected in the Inbox). The toolbar displays a number of options, but you will not see the Follow Up button. You will need to click on the Actions menu to set a follow up from the Preview Pane view.

This message displayed in the Preview Pane has some attachments. To open an attachment, simply double-click on it. Outlook will attempt to determine what type of file is attached, and will launch that software application and display the document. Close the document and it will remain attached to the message in your Inbox. If you move the message, the attachment will stay with the message in its new location.

To scroll through messages in this view, use the Up and Down arrow keys on the keyboard.
HANDLING MESSAGES AS THEY ARE READ

After you read a message, you can handle it in a number of ways: Reply to it, Forward it, Flag it, Move it, Print it, or Delete it.

Replying to Messages

With the message either open in a separate window, or selected in the Inbox, click on the Reply button.
A reply window will open, with the cursor blinking at the top of the message field. Type in your response and click on the Send button.

A copy of your reply will automatically be placed in the Sent Items folder. In the Inbox, the icon beside the message will change to indicate you have replied to the message.

Some options that you have when replying to a message include replying to the Sender only, or to all recipients of the message. The simple Reply button sends the reply to the Sender only, while the Reply All button sends the reply to the Sender as well as all other Recipients of the original message.

A copy of your reply will automatically be placed in the Sent Items folder. In the Inbox, the icon beside the message will change to indicate you have replied to the message.

There are other options that you may use that are standard for replying, forwarding and sending. Those options will be discussed under the Sending Messages instructions.

Forwarding Messages

You may wish to forward a message to another user. With the message open in a separate window, or selected in the Inbox, click on the Forward button.
In the To: field, type in the address of the person to whom you are forwarding the message. As a courtesy, you should type in some comments at the top of the message you are forwarding. Click on the Send button.

Again, a copy of this message will be placed in your Sent Items folder. In the Inbox, the icon beside the message will change to indicate you have forwarded the message.

Special Note About Forwarding: Sometimes when a message is forwarded, the e-mail address of the original sender drops off and the person to whom you forward the message only sees the name of the original sender. If it is important to retain the original sender’s e-mail address, please see special instructions for a work around to this issue at the end of the manual under “Some Notes About Outlook 2001 for the Mac”.
Flagging a Message

You may flag a message to bring it to your attention and/or to be reminded to perform some action at a future date--follow up on the message, reply to it, etc.

Flagging a message places a red flag icon next to the message in the Inbox. Example:

With a message open in a separate window, click on the Follow Up button. (Or, with a message selected in the Inbox, click on the Actions menu, and select Follow Up.)

This dialog window will appear. You can use the spinner buttons to select the type of flag you want--Follow Up, Read, Reply, etc.

You may set a due date and time. If you do, you will receive a reminder. To set a due date and time, first click in the checkbox for Due by and then select a date and time. Click on the calendar button to select a date and use the spinner buttons to select a time.

After you click on the OK button, a red flag will appear next to the message in the Inbox.
Follow Up Reminder Screen

If you set a due date for the follow up, you will see a pop-up reminder at the due time. Reminders only pop up while Outlook is running.

Clearing or Completing a Flagged Item

After you flag a message, a red flag icon appears beside the message in the Inbox. After you complete the follow up action, you may open the message and click on the Follow Up button. You may click on the Clear Flag button to remove the flag icon, or click in the Complete checkbox, to change the flag icon from red to white. Then click on the OK button.
Printing a Message

Open the message in a separate window, or select the message in the Inbox. Click on the printer button and the message will print to the default printer. To select a different printer, click on the File menu and select Print. At the dialog window, select a different printer.

Deleting a Message

Open the message in a separate window or select the message in the Inbox. Click on the Delete button. The button may appear as shown here, or simply as a red "X." The message will be moved to the Deleted Items folder.

The default for the Deleted Items folder is that items will remain in the folder until you manually empty it.

*Manually Empty the Deleted Items Folder*

Click on the Tools menu and select Empty Deleted Items Folder. This warning will be displayed. Click on Yes to permanently delete the items.

![Warning Message]

*Setting Delete Options*

You may change this option so that all items will be permanently deleted from the Deleted Items folder when you exit Outlook.

You can change these settings by clicking on the Edit menu and then selecting Preferences. Then click on the General button on the left. You will see these default settings:

![Options]

By default, you will be warned before permanently deleting items, (when you delete them manually), but you can change this option to empty the Deleted Items folder when you exit Outlook. If you select this option, you will NOT see a warning before the items are permanently deleted.

Note that items in your Deleted Items folder take up some of your allotted space on the server.
Retrieving Items from the Deleted Items Folder

You may retrieve items while they are still in the Deleted Items folder, but once you have permanently deleted them, it is no longer possible to retrieve them via the Outlook desktop client. There is a special option in OWA (Outlook Web Access) that allows you to recover items if they have recently been emptied from the Deleted Items folder.

1. Click on the Deleted Items icon
2. Select the item(s) you want to retrieve.
3. From the Edit menu, select Move to Folder.
4. From the Move dialog window that displays, select a folder, or click on the New button to create a new folder.
5. Click on the OK button.

Note that the Deleted Items folder contains E-mail messages, Tasks, Calendar entries, etc., all of which may be retrieved from the folder. If you are retrieving a Task, of course you will move it to the Tasks folder.

Deleted items stay in this folder until you empty the folder. To empty the Deleted Items folder, click on the Tools menu, and click on Empty Deleted Items folder. You will see a prompt that asks you if you are sure you want to permanently delete the selected items. Click on Yes to empty the folder.
Moving a Message

Select the message in the *Inbox* and click on the *Move* button. At the dialog window, you may need to click on the triangle button beside the *Mailbox* icon and then the triangle button beside the *Inbox* icon to expand the *Inbox* to display any folders that you created under the *Inbox*. If folders exist, select the folder you want to move the message into and click on the *OK* button. The message will be *moved out* of the *Inbox* and *in* to the folder you selected.

*Creating a New Folder*

If you have no folders under your inbox, or if you don’t have a folder appropriate for moving the message into, you can create a new folder from this *Move* dialog window. To create a new folder, click on the *Inbox* icon to select it. Then click on the *New* button.
The *Create New Folder* dialog window appears. Type in a name for the folder, make sure the type of folder is a *Mail Folder* and make sure the *Inbox* icon is selected. Click on the *OK* button.
Organizing Your Mail Messages

You may want to organize your mail into separate folders to make it easier to find specific messages.

To create a new folder, click on the drop-down button next to the New button on the toolbar. From the drop-down menu, click on Folder. The dialog window shown below will appear.

Type in a name for the folder, indicate that it is a Mail Folder, and expand your Mailbox icon if necessary, so the Inbox icon is displayed. Click on the Inbox icon to select it, and then click on the OK button. The new folder will appear under the Inbox. Continue to create folders in this manner. The folders will be arranged in alphabetical order under the Inbox folder icon.
**Example of Folders under an Inbox**

The folder names that appear in boldface have messages that have not been read. The number of unread messages appears in parentheses beside the folder name.

To display the contents of a folder, click on the folder icon.

**Using Rules to Move Messages to Folders**

You may set up your own rules to move messages directly to folders, and allow the messages to bypass the *Inbox*. You may do this for messages that are sent to a particular listserv, keeping all the messages in one folder, and only viewing that folder when you have time. You may also set up a rule for moving messages from a particular person to a special folder, again, bypassing the *Inbox* and keeping all the messages from that person in a single folder.

Other possibilities:
- Make a **copy** of the message and send the copy to a special folder
- Display a special alert window when the message arrives
- Play a special sound when the message arrives
- Delete the message
- Forward the message

Rules will only run on new, incoming messages. You are not able to run the rule on messages that have already arrived in your *Inbox*. 
Creating a Rule

To create a rule, click on the Tools menu and select Rules. At the next dialog window, click on the Add Rule button. At this dialog window, create the rule. In the top part of the dialog window, set the conditions that you are looking for (message from a particular address or to a particular address, keywords in the subject or message body, etc.) Make sure to click on the Check names button if the address in the From or Sent to field is not underlined.

In the lower part of the dialog window, set the action(s) you want performed when an incoming message meets the conditions you’ve set. If you check Do not process subsequent rules, that means if the conditions of another rule are met, the second rule’s actions will not be processed.

When finished with the conditions and actions, click on the OK button.
Example of a Rule

The name in the From field was selected from the Global Address List. You may also select a name from your own Contacts list or you may simply type in a person’s e-mail address in the From field. If the name is not underlined, click on the Check Names button. (Note that if you want to set a rule for messages that are posted to a listserv, you will type in the listserv name in the Sent To field, since messages are sent TO a listserv, and are not actually FROM the listserv, but are FROM individual persons.)

When a message arrives from Karen Wenz, an alert with special actions will occur and a copy of the message will be placed in the Outlook Class folder.

See the next page for the Alert Actions.
**Setting the Alert Actions**

When you click on the *Actions* button, you will see this dialog window. Type in the notification message that you want to display when an incoming message meets the criteria for the rule. Check the box for *Play a Sound* if you want a sound to play when the message arrives. Then click on the *OK* button.

---

**Example of an Alert Action**

When a message arrives that meets the criteria in the rule, this alert screen displays. At the same time, an alert sound will be played. You may click on the *Open Item* button to view the message, or you may simply close this alert window and open the message later.
Examples of Rules

This is a list of rules. Note that they will be applied in the order shown. You may move rules up or down in the list by using the buttons on the right.

Change Rules

Go to the Tools menu and select Rules. Click on a rule and click on the Edit Rule button. Make the desired changes and click on the OK button.

Delete Rules

Go to the Tools menu and select Rules. Click on a rule and click on the Delete Rule button. Click on the OK button.

Changing the Order of Rules

Go to the Tools menu and select Rules. Click on a rule and click on the Move Up or Move Down button to change the order of rules. (Rules will be applied from the top down in the rules list.) Click on the OK button to confirm the changes.

Suspending a Rule Temporarily/Re-establishing a Rule

Go to the Tools menu and select Rules. Click in the checkbox beside the rule you want to temporarily suspend to remove the checkmark. Click on the OK button. To re-establish the rule, go to the same window and replace the checkmark beside the rule. Click on the OK button.
Maneuvering in the Inbox

You may use the arrow keys on the keyboard to move up and down in the Inbox when you are using the Preview Pane.

When you open the message in a separate window, you will see buttons with an Up and a Down arrow. Clicking on these buttons will move you to the next or previous message in the Inbox.

Change Options for Reading Mail

As you are reading messages, you may be deleting some, responding to some, etc. You may select the way you wish to move through your messages by clicking on the Edit menu and selecting Preferences.

Click on the Reading button under the Mail category.

Select the way you want messages marked when using the Preview Pane.

If you check the box to “Show text in Preview Pane header,” you will see the From, Subject, To and Cc fields between the two panes.

Indicate what you want to happen after you move or delete an open mail item.

Click on the OK button to save the settings.
VOTING BUTTONS

Outlook/Exchange has a voting button feature that is similar to the feature used when replying to an e-mail invitation to a meeting. The voting button feature can collect responses from both Macintosh and Windows users, but only Outlook for Windows can initiate the voting button feature.

RESPONDING TO A VOTING BUTTON MESSAGE

As a Mac user, you may receive a message that asks you to vote on something. When you open the message in its own separate window, you will see the voting buttons. The example below asks the recipient to vote on predicting the amount of snowfall for the winter.

The yellow banner in the message asks you to respond to the voting buttons. Simply click on the button that indicates your vote (there are no write-ins available). You will see this dialog window:

You may click on the No button to simply send your vote, or click on the Yes button to add comments before sending the response.

If you click on your vote button and then click on the No button at the next dialog window, your message will be sent with your voting response in the subject line of the e-mail message and nothing in the body of the message.
**INCLUDE COMMENTS WITH A VOTE**

If you click on *Yes*, you will see a dialog window that indicates your vote selection in the subject line, and allows you to type in your comments in the body of the message.

![21-30": vote on this - Message](image)

The recipient of your vote sees your response in the subject line, but will have to open up your message to see any special comments you made. The vote responses themselves are automatically tallied by the originator of the voting question.
SENDING A MESSAGE

With the Inbox displayed, click on the New button and the new message window appears.

OR use the keyboard shortcut ⌘ + N.

There are three ways to address messages.

1. Type in the entire e-mail address in the To field. Separate addresses with semicolons.
2. Click on the To button and select a name from the Global Address List. Switch to Contacts to select a name from your own Contacts folder.
3. Type in a name or part of a name (you may use first or last name) and then click on the Check Names button on the toolbar. If you want to type in more than one name, separate the names with semicolons.

Outlook will search for the name in the Global Address List and/or your own Contacts folder.
THE GLOBAL ADDRESS LIST

If you click on the To button in the new message window, you will be taken to this dialog window, where you may select names from the Global Address List and/or your own Contacts list. Use the spinner buttons to select the place you want to look for names.

Select a name from the left side and click on the To button. You may continue to select more names and click on the To button to add them as recipients. You may also place some names in the Cc field. You can type in the first few letters of the person’s last name to jump to that place in the Global Address List.

When finished selecting names, click on the OK button in the lower right corner of the window.

Note that the Global Address List is derived from the names in the Human Resources database, which typically has people’s legal names, rather than nicknames. Example: Robert instead of Bob, Thomas instead of Tom.
SELECTING A NAME FROM A DIFFERENT LIST

Click on the spinner buttons to see other available lists.

Note that you can display just the SCSU Faculty and Staff, or just the SCSU students. The Global Address List includes all faculty, staff and students, so if you are looking for faculty and staff only, it’s more efficient to use the Users—SCSU Faculty and Staff list.

If you want to display your Contacts, click on Contacts at the bottom of the list.
**AUTO ADDRESSING**

Instead of using the *Global Address List* manually, you can use *Auto Addressing*.

At the new message window, type in a person’s first or last name in the *To* field and click on the [Check Names] button, or use the keyboard shortcut `⌘ + K`. Typically, this works best when you type in just the first or just the last name, or even the first few letters of a first or last name.

The *Global Address List* will be searched for the name. If no match is found in the *Global Address List*, your *Contacts* folder will be searched next. **

But, if a match is found in the *Global Address List*, the *Contacts* list will not be searched. If the match found in the *Global Address List* is not the person you want, click on the *Address Book* button on the toolbar and select a name from your *Contacts* or other folder.

** If you prefer that your *Contacts* list be checked first, change the default. From the *Edit* menu, select *Preferences*, and under the *Mail* heading, select *Address Book* and under the heading for *Show This Address Book First*, select the *Contacts*. (Don’t select *All Contacts.*) Click on the *OK* button. From then on, when you use *Check Names*, it will first check your personal *Contacts* list and if it finds no matches, it will check the *Global Address List*. If it finds a match in your *Contacts* list, it will not search the *Global Address List*. 

Page 36
Multiple Matching Names

If you use the Check Names feature and more than one name is found, all matching names will be listed. Click on the name you want and click on the OK button.

If none of the matches are the one you want, click on the Show More Names button to select a different list to search, such as your Contacts list.
COMPLETING THE MESSAGE

After completing the address information, type the message.

You may use the ABC checkmark button to run a spell check.

When finished, click on the Send button. (Or use the keyboard shortcut, ⌘ + Return.) The message will be sent and a copy of it will be placed in your Sent Items folder.
SENDING TO MULTIPLE RECIPIENTS

If you want to send a message to more than one person, type in the names and separate them with semicolons. You may use a mix of last names and first names—in this case, the last name Michaels is used and the first name Lucinda is used. When using Auto Addressing, both the last and first name fields in the Global Address List are searched. After using the ³ + K keyboard shortcut, or clicking the Check Names toolbar button \[\text{Check Names}\], the search results will display the name of the person if only one match is found, or will list all matches and allow you to select the name you want to use (see Multiple Matching Names screen a few pages back).

TIP: If you frequently send messages to the same group of people, it is most efficient to create a distribution list (instructions covered later in manual).
SIGNATURES

A signature is a block of text that you create once and then use over and over again, whenever you send an e-mail message. A signature typically includes your full name, your title or position, company name, business address, e-mail address, phone number and fax number and any other information you may use to allow others to communicate with you.

Multiple Signatures and Default Signature

You may set up more than one signature. For e-mail that is sent within your company, you may have a shorter signature and for people outside your company, you may need to include more information in your signature.

You may set one of your signatures as the default signature, which will always be used unless you specify a different signature for an individual message.

Creating a Signature

From the Tools menu, select Signatures and at this dialog window, click on the New button.

![Signatures Dialog Window](image-url)
At the next dialog window, type in a name for this signature and type all the text you want to include in the signature. If you want to format the signature, make sure all the text is selected first. To change the character format (bold, italic, font color, change font) click on the *Font* button. To align the signature, (center, left, right) click on the *Paragraph* button. When you've completed the signature settings, click on the *Save* button.

You may create more signatures. After creating one or more signatures, click on the one you want as your default signature and click on the *Set as Default* button. You will need to check the box to indicate that you want the default signature to be added to the end of all outgoing messages. You may also wish to check the next box so the signature won’t be added to messages that you forward or to messages to which you reply. Then close this window.
Changing a Signature

From the Tools menu, select Signatures and select the name of the signature you want to change. Then click on the Edit button. Make the necessary changes and click on the Save button.

You can also change which signature should be used as the default signature, or turn off the default signature altogether at any time.

Using the Default Signature

Each time you create a new message, the signature that you set as the default will automatically appear in the new message window. If you don’t want a signature in a particular message, simply highlight the signature and press the Delete key.

Using a Different Signature

If you want to use a different signature for a particular message, in the new message window, highlight the default signature text and from the Tools menu, click on Signatures. Select the signature you want to use and click on the Insert button. The selected signature will be inserted into the new message, replacing the default signature there. This will not override the default signature in future messages.
**INSERT A FILE IN A MESSAGE**

You may insert a file with an e-mail message. Position your cursor in the message body and click on the *Insert File* button.

Maneuver to find the file location and click on the filename to select it. Click on the *Open* button. An icon that represents the file will appear in the body of the message window. When the message is sent, the file will be sent as an attachment with the e-mail message.
Sender's View of Outgoing Message Window

The file attachment appears as an icon in the body of the message. The sender clicks on the Send button to send the message with the attachment.

Recipient's View of Incoming Message Window

When the message is received, the recipient sees the icon and can double-click on it to open the file. Of course, the recipient needs to have the software for that particular file type in order to open the message.
Security for Attached Files

To protect the possible transmission of viruses, the Exchange server has built-in security that checks incoming attachments for possible viruses. As another security measure, when you open some file types that are more prone to transmitting viruses, Outlook will display a warning screen. At this screen, you may save the file to disk, open it directly, or cancel. If you are certain the file is safe, save it or open it.
Saving Attached Files

If you delete a mail message that has a file attached to it, you are also deleting the attachment. If you need to save the attachment, open the message, hold down the Control key and click on the attachment icon. At the pop-up menu, select Save File As. At the next dialog window, select a location to save the file and either keep the file’s original name or type in a new filename.
**INSERT AN ITEM IN A MESSAGE**

You are able to send *items* in Outlook. Items are individual contents of Outlook folders. An example of an item would be a distribution list, which is an individual item in the *Contacts* folder. You could also send an individual contact to another user. Other items would include individual task entries in the *Tasks* folder. This example will cover the steps for inserting a distribution list.

Start a new message and with the cursor in the body of the message, from the *Edit* menu, click on *Insert* and then click on *Item*. You will see a dialog window like this. You may need to expand the *Mailbox* to see the *Contacts* and other folders. Click on the *Contacts* icon and the contents of that folder will be displayed in the area below. Scroll through this list to find the distribution list you want to insert, and click on the distribution list name to select it. Then click on the *OK* button. An icon will appear in the body of the message (see next page) and when you send the message, the recipient will see the icon when the message is opened.
Sender’s View of a Message with an Item Attached

In the outgoing message window, an icon will represent the item you inserted (in this case, it's a distribution list). Click on the Send button.

Recipient’s View of a Message with an Item Attached

When the recipient opens the message, the item will appear as an icon in the message window. With the Folder List displayed, the recipient can drag the icon from the message window and drop it onto the Contacts icon in the Folder List.
OPTIONS FOR SENDING INDIVIDUAL MESSAGES

You may use special options on individual messages that you send. You may want to bring a message to the recipient’s attention by marking it of high priority. Or, you may want to use a sensitivity setting to alert the recipient about a message that is confidential.

These options on individual messages are set on a message-by-message basis. The settings do not become the defaults.

Sensitivity

The default sensitivity is Normal. You may set the sensitivity as Confidential, Personal or Private. This feature only works when the recipient is using Outlook and is on the same server as you.

Priority

The default priority is Normal. You may set the priority as High or Low. This feature only works when the recipient is using Outlook and is on the same server as you. Note: The Low priority option is not often used 😂.

Read Receipt

You may request a Read Receipt. This is an automatic response that is generated by the server when the recipient reads the message you sent. This feature only works when the recipient is using Outlook and is on the same server as you.

Delivery Receipt

You may request a Delivery Receipt. This is an automatic response that is generated when the recipient receives the message you sent. This feature usually works even if the recipient is not using the same server that you use.

Delayed Delivery

You may request that a message be delivered at a later date. The message will bear a time stamp for the date and time that you created it, but delivery will be delayed until the date and time you request. This feature works on all messages you send out, regardless of whether the recipient is on the same server as you.
Using Priority (Importance) Settings and Sensitivity Settings

Create a new message and in the new message window, click on the Options button.

This dialog window appears, and you may set the priority and the sensitivity. These options are set individually on messages. They do not become the default options. These options determine how the message will be displayed to the recipient. Only recipients who use Outlook will see these priority and sensitivity banners.

The default priority level is normal. You may change it to High or Low.
The default sensitivity is normal. You may change it to Private, Confidential, or Personal.

Click on the OK button after making your selections. This returns you to the new message window where you can complete the message and send it.
**Viewing a Message Sent with Sensitivity**

A message with sensitivity other than normal will display like this when it is opened in its own separate window (but **not** when read by using the Preview Pane). The confidential banner is simply a courtesy request and does not actually prevent the recipient from printing or forwarding the message.

---

**Viewing a Message Sent With High Priority Setting**

A message sent with high priority will display a Red Up Arrow in the *Inbox*. When the message is opened in its own window, it displays a banner that indicates it is of high priority.
Read Receipts and Delivery Receipts

You may also request a Read Receipt and/or a Delivery Receipt from the Options dialog window. The Read Receipt is designed to notify you when the recipient has opened your message. The Delivery Receipt simply informs you that the message has been delivered. These receipts come to you as e-mail messages that are generated automatically when the recipient reads the message you sent.

- The Read Receipt feature generally only works with other users who are on the same Exchange server as you.
- The Delivery Receipt feature usually works regardless of whether the recipient is on the same server as you.

Also note that by default, the feature to Save copy in ‘Sent Items’ folder is checked. This ensures that a copy of every message you send, reply to, or forward will be saved in a special folder. This helps you to keep track of all your outgoing messages. This feature works for ALL messages you send, regardless of whether the recipient is on the same Exchange server.

![New Item Properties dialog box](image_url)
Automatically Generated Response to a Read receipt.

When you check the box for the Read Receipt option before sending a message, after the recipient has read your message, this e-mail message will appear in your Inbox.

It displays a green, opened envelope icon and appears to be from the recipient. The subject line of your original message is preceded by the word Read: and the date and time the recipient read the message are displayed. If you open the message, you will see the same information as shown in the Inbox, so it is not necessary to actually open the message.

You will probably want to use the Read Receipt feature sparingly, as it could become annoying to receive a receipt for every message you send. Remember, the Read Receipt feature is available only between you and other people who are using the same Exchange server, and using Outlook.
Delayed Delivery

You have the option to set the time when a message will be delivered—you may want to compose the message now, but don’t actually want it delivered to the recipient yet. You can delay the sending of the message by minutes, hours, days or weeks, by indicating when you want it delivered. The default is to send all messages immediately, but to delay the sending of an individual message, you can use the Options button in the New Message window.

In the New Message window, click on the Options button and then click on the Send Options button in the lower left corner of the window.

Click on the Microsoft Exchange Server tab and you will see this dialog window:

![Send Options for this Message dialog window](image)

You can set a time (in minutes, hours, days or weeks) and then click on the OK button. Type a number in the text box and use the spinner buttons to select minutes, hours, days or weeks. Complete the message and click the Send button. The message will be delivered in the time frame you indicated.
**Time Stamp on Delayed Delivery Messages**

NOTE: The recipient will see the time that you **composed** the message (rather than when it was actually **delivered**). It will appear chronologically in the *Inbox*, among other messages based on the time stamp on the message.

The message with the subject line of “2 min from 3:52” was composed at 3:52, but delivery was set for 2 minutes later. A message with the subject line “right now” was sent at 3:53 and delivery was set for immediately. The delayed message was delivered at 3:54, but the time stamp is still 3:52, the time the message was composed.

<table>
<thead>
<tr>
<th>From</th>
<th>Subject</th>
<th>Received</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wenz, Karen L.</td>
<td>right now</td>
<td>Today, 3:53 PM</td>
</tr>
<tr>
<td>Wenz, Karen L.</td>
<td>2 min from 3:52</td>
<td>Today, 3:52 PM</td>
</tr>
</tbody>
</table>

**ABOUT E-MAIL SENDING OPTIONS**

The special options used when sending e-mail messages via Outlook are consistent when both the recipient and sender are using Outlook on the same Exchange server. If the recipient uses a different software application for reading e-mail, the sensitivity and priority banners will not display.

This is also the case when using the *Read* receipt feature. If the recipient is using Outlook and is on the same Exchange server as the sender, the *Read* receipt feature will work. However, in most cases, the *Delivery* receipt feature will work even if the recipient uses a different software application for reading e-mail.

The delayed delivery feature will work regardless of whether the recipient is on the same server as you.
OUT OF OFFICE ASSISTANT

OVERVIEW

When turned on, this feature automatically sends replies to e-mail messages that you receive when you are away from your office for extended periods—on vacation, at conferences, etc. During these times, you may not choose to (or may not be able to) check your e-mail, yet you don’t want people to think you are ignoring their messages. The Out of Office Assistant allows you to set a message that will respond to e-mail messages, indicating that you are away from your office. This feature works only with other users who are on the same Exchange server.

TURNING ON THE Out of Office Assistant

Click on the Tools menu and select Out of Office Assistant. At this dialog window, type in the auto reply that you want to be sent. Click in the radio button for I am currently Out of the Office and click on the OK button.

Each person will only get the auto reply one time during the time period it’s set. If you turn on the auto reply feature and set your auto reply message, the first time a person sends you a message, the auto reply message will be sent to that person. The next time that same person sends you a message, the auto reply message will not be sent.

You do not need to leave Outlook open and running on your computer to make the Out of Office Assistant work. The auto reply message is generated by the Exchange server.
TURNING OFF THE OUT OF OFFICE ASSISTANT

Make sure to turn off the *Out of Office Assistant* when you return to your office.

When you log on to Outlook, you will see this prompt. Respond by clicking on the *Yes* button.

![Out of Office is currently on. Would you like to turn it off?](image)

RESPONSES TO LISTSERV MESSAGES

If you have turned on your *Out of Office Assistant*, and you receive a message that is sent to the SCSU listserv by a person who is on the SCSU Exchange server, your auto reply message will be sent ONLY to the person who posted the message to the listserv, **not** to all the people who are subscribed to the listserv. Your auto reply feature sends replies to people who send messages to you. Individual people send messages to listservs, so your auto reply goes to the individual person--not to all the people subscribed to the listserv.

If you **post** a message to an SCSU listserv, you will get auto reply messages from any people who currently have the auto reply feature turned on at the time you send the message to the listserv.
DEFAULT E-MAIL PREFERENCES

To customize your e-mail settings, go to the *Edit* menu and select *Preferences*. You can set default preferences here. These defaults will apply to all new messages you send.

The dialog window displays categories on the left side and the features for those categories appear on the right side of the window. Select an item from one of the categories to display the options that you may customize. The defaults for *General* settings are displayed here.

When you change any settings, you need to click on the *OK* button to confirm the changes.
**CHANGE DEFAULT E-MAIL SPELLING OPTIONS**

You may set Outlook to *Always check spelling before sending*. You may also select other options for the way the spell check feature works.
CHANGE DEFAULT E-MAIL READING OPTIONS

These are the default settings for reading mail.

Make note that by default, after a message is read, the item above it in the *Inbox* will be opened next.

Messages will automatically be marked as read as soon as a different message is selected.
CHANGE DEFAULT E-MAIL SENDING OPTIONS

These are the default settings for sending messages. Note that when you set a default here, it will affect ALL new messages that you send. Unless every single message you send is important or confidential, you should keep the sensitivity and priority options as normal. You can mark individual messages as important or confidential by using the Options button in the New Message window.

The same is true for the Read and Delivery receipts. You typically will not want to get receipts for every single message you send, so those options are best used on individual messages.

One very important feature here is the Save a copy of the item in the ‘Sent Items’ folder. By default, this feature is turned on. It saves a copy of everything you send, and keeps it in a separate folder called Sent Items. This is very useful because it ensures that you maintain a copy of everything you send, and you do not have to remember to send a copy to yourself.

Another important feature is the last one for replying to or forwarding a message. By default, the original message is kept with the reply or forward, the original message is indented to distinguish it from your reply text, and after you reply or forward a message, the original message is closed and returned to your Inbox.

It is a good practice to always include the original message in a reply. It is considered a general courtesy in e-mail etiquette.
CHANGE DEFAULT E-MAIL ADDRESS BOOK OPTIONS

To change the default address book that you see, or to change the order in which Outlook searches for addresses when using the Check Names feature, select Address Book under the Mail heading.

See the descriptions on the next page to learn which address books are available.

- Indicate which address book you want displayed as the default under the Show this address book first heading.
- Make sure that your personal addresses are kept in the Contacts folder.
- You may select which book should be searched first when using the Check Names feature. You may want to switch this to Users-SCSU Faculty and Staff to avoid the multiple matches you may get if the Global Address List (which includes students) is searched during the name check.
- Use the up and down arrow buttons to move the address books into the order in which you want them to be searched.

Click on the OK button to save the changes.
ADDRESS BOOK DESCRIPTIONS

GLOBAL ADDRESS LIST

The Exchange server has a comprehensive address book that lists everyone on the server, including faculty, staff, administrators and students, as well as department e-mail accounts. This comprehensive address book is called the Global Address List or GAL.

The list includes this information about employees: the person’s full name, office phone number, campus address and Huskynet ID. For students, the list includes the full name and Huskynet ID.

By default, when you click on the Address Book icon on the toolbar, or when you click on the To button in the New Message window, you will be taken to the Global Address List.

There are some subsets of the Global Address List. One includes only listings for faculty, staff and administrators. Another includes only listings for students. Yet another includes only listings for departments. These subsets are found by clicking on the spinner buttons under the Show names from the: heading.

SCSU CAMPUS ADDRESS LISTS

Groups (distribution lists)
Users—All SCSU Users (faculty, staff, students and departments)
Users—Department Accounts (only department accounts)
Users—SCSU Faculty and Staff (only faculty, staff and administrators)
Users—SCSU Students (only students)

You may opt to select one of these subsets as your default, rather than using the comprehensive Global Address List. Change the setting at the dialog window for Address Book options.

CONTACTS FOLDER

You also have an address book that stores your own personal e-mail addresses for people who are not on the same Exchange server. You can also create your own distribution lists. Both the individual addresses and the distribution lists that you create are stored in the Contacts folder, which is stored on the Exchange server.

You do not need to create entries in your Contacts for people who are in the Global Address List.
CONTACTS

Contacts are entries that you create for your own use. They include (at a minimum) the person’s full name and e-mail address. You can add other information if you want, but the name and e-mail address are essential. Your contacts are stored on the server and are available only to you. This is different from the Global Address List, which is available to all Outlook users on SCSU’s Exchange server. Contacts may include entries for individual people or entries for groups of people (referred to as Distribution Lists).

CREATING A NEW CONTACT

Select the Contacts icon from the Outlook Bar and click on the New button. At the dialog window, type in the information you want to store for this individual. At a minimum, you will want to include a full name and an e-mail address. You may also include other details, such as mailing address, phone numbers, etc.

Note: If you create subfolders under the Contacts folder, and store any of your contacts in the subfolder, the Check Names feature won’t be able to find them. The only way you’ll be able to see the entries will be to display the Folder List and send messages directly from the Contacts.
Contact Full Name Title and Suffix

After you type in a first name, a new window will appear that allows you to add a prefix (Mr. Ms., etc.) and a suffix (I, Jr., etc.) if you wish. If you don’t want to include a prefix or suffix, just click on the OK button.
Contact Mailing Address

If you want to include a mailing address, click on the spinner buttons to indicate Business, Home or Other.

![Business Address:](image)

Then, click on the *Edit This Address* link below the address box.

This dialog window will appear and you can type in the address information and then click the *OK* button. In order to later use a special mapping feature, make sure that the first line of the address is the street address (not a company name or P.O. Box) and make sure to use only the first five digits of the zip code. Type in all the address information and click on the *OK* button.
SAVE THE CONTACT

After completing the full name and address information, you will be returned to the main New Contact window where you will click on the Save and Close button in the upper left corner of the window. The entry will be added to your Contacts folder.

The new entry appears in the Contacts folder.
CREATING A NEW CONTACT FROM AN EXISTING MAIL MESSAGE

It is most convenient to create new contacts from existing messages in your Inbox.

From the Inbox, select the message so it displays in the Preview Pane, or double click on the message to open it in a separate window. Click on the name or address that appears in the From line.

![Outlook 2000 Message](image)
This dialog window appears, displaying information about the sender. Click on the *Personal Address Book* button at the bottom of this window to add the person to your *Contacts* folder.
A dialog window will appear for the new contact, allowing you to type in additional information.

Click on the *Save and Close* button in the upper left corner to save the new contact.
GENERATING A MAP FROM A CONTACT ENTRY

If you include a street address for an individual contact entry, you may generate a map and get driving directions to the address. This is generated through your default web browser, using Expedia.com.

Open the contact entry and click on the Map of Address button.

(Note that the first line of the address field must be the STREET address (not the name of a company or a P.O. Box). The zip code must be only 5 digits long. Of course, it also must be a valid address.

The default web browser will launch and generate a map to the address.
You will see a map of the address, with surrounding streets labeled. You may click on the link below the map to get driving directions to the address. You will be asked to type in an address for the starting point and then detailed directions to the address destination will be generated.

Note that you can zoom in and out on the map.

Search results
2316 Rice Lake Rd, Duluth, MN, 55811

Print this map  Save this map  E-mail this map

Other options

🔗 Get driving directions to this location

You may print the map and the driving directions. You can close the web browser when finished, and return to Outlook.
DISTRIBUTION LISTS

When you frequently send messages to the same group of people, it is convenient to create a distribution list. The list has a name that you choose, and it includes the names and e-mail addresses of all the people you choose to include. This list will appear as an entry in your Contacts folder.

Creating a Distribution List

Click on the drop-down button next to the New button on the toolbar. From the menu list, click on Distribution List.

At the dialog window, type in a name for the distribution list. Then click on the Address Book button to select people from the Global Address List or from your Contacts.
Selecting Names from the Global Address List

Select names that you want to include in the distribution list. You may type the first few letters of a person’s last name to jump to that part of the list. You may use the spinner buttons in the upper right corner of the window to view only Faculty and Staff, or some other group, (including your own Contacts entries). This will help to narrow down the list so you don’t have to look through countless Johnsons or Millers.

Selecting Names from Your Contacts Folder

If you want to add people who are in your Contacts folder, use the spinner buttons in the upper right corner to display the contents of your Contacts.

You can double-click on a name on the left to add it or click on the name and then click on the Add button. When you’ve found all the names you need, click on the OK button in the lower right corner of the window.
The names of all the people you added will appear in the list.

Adding a New Recipient to a Distribution List

If you need to add more people who aren’t either on the Global Address List or your Contacts list, click on the Add New Recipient button.

At this window, you can type in the person’s name and e-mail address. If you want to also create an individual entry for this person in your Contacts folder, you can click in the checkbox to Add to Contacts. Then click on the OK button.
CALENDAR

Outlook provides an electronic calendar that stores your appointments on your account on the Exchange server. Because this information is stored on the server, you may access it from anywhere, using a web browser.

OVERVIEW OF THE CALENDAR

This calendar is displaying the *One Day* view. The *Date Navigator* on the right displays the next few months’ dates. You may click on any date on the navigator to display that day of your personal calendar. The Oct. 23 date is selected on the *Date Navigator*, so that day is displayed on the Outlook personal calendar. Dates that appear in boldface in the *Date Navigator* have at least one calendar entry. Dates in plain typeface have no calendar entries.

There are several calendar entries for the day. The *bell* icon on an entry indicates that a reminder is set for that entry. The *house* icon appears next to the location of the appointment or meeting. The *double curved arrows* indicate that this entry is a recurring appointment or meeting that is repeated on a regular pattern (weekly, monthly, etc.)

Note that there is a double booking on this date. Two appointments overlap. One is from 9:30-10:30 and another is from 10:00-11:30.

Color Codes

There are four different colors to designate busy/free times. **Dark blue** means you are **busy** at that time, **light blue** means you have a **tentative** commitment, **purple** means you are **out of the office** and **white** means you are **free**. By default, everything appears as white (free time) until you designate it otherwise.
VIEWING THE CALENDAR

You may view your calendar in a number of different ways. Use the calendar toolbar to display the current date—Go To Today or click on the button next to Change View to select from the options of viewing 1, 2, 3, 4, 5, 7 days at a time, or an entire month.

Date Navigator

Use the Date Navigator to jump to a different date. Click on a date to make that date display on your calendar. Note that numbers that display in boldface in the Date Navigator have at least one entry on that date. Numbers that do not display in boldface have no entries on that date.

Go to a Specific Date

Use the ⌘ + G keyboard shortcut to display this dialog window. Type in the desired date and press the Return key. The date will display on the calendar.
**TYPES OF CALENDAR ENTRIES**

You may create several different types of entries on your calendar.

**Single Event**—an appointment or meeting that occurs only one time

**Recurring Event**—a meeting or appointment that occurs more than once, on a regular basis, for the same duration (example, a one-hour staff meeting that occurs once a week)

**All Day Event**—an event that lasts all day, but doesn’t necessarily mean you are busy during the entire event. An example of an event may be a holiday (Thanksgiving), a birthday, a campus event (Mainstreet Day). An All Day Event is displayed on the calendar at the top of the day, rather than on a specific time slot on the calendar.

**Meeting**—a meeting is a special event that you are invited to via e-mail. There is an electronic scheduling feature that uses Outlook e-mail together with the Outlook calendar. Meeting invitations arrive via e-mail and responses are sent via e-mail. The meeting is automatically placed on your calendar after you accept the invitation. If you decline the invitation, the meeting is NOT placed on your calendar.

**Example of An All Day Event**

Banner appears across the top of the date

![Example of An All Day Event](image1)

**Example of a Meeting**

Double head & shoulders icon appears on a meeting entry. This is a recurring meeting.

![Example of a Meeting](image2)
**ADDING AN INDIVIDUAL ENTRY TO YOUR CALENDAR**

Navigate to the date by clicking on the date on the *Date Navigator*. Point to the time slot for the new appointment and double-click. A *New Appointment* window appears.

Type in the subject of the appointment and the location. The start date and time will already be correct, because you clicked on that timeslot on your calendar. The default duration is 30 minutes, so you may need to use the spinner button for the end time to change it.

You will automatically get a reminder 15 minutes prior to the appointment start time. You can adjust the reminder time, or remove the checkmark to forego a reminder.

Your time will automatically be marked as “busy” on your calendar.

When finished, click on the *Save and Close* button in the upper left corner to place this appointment on your calendar.

![Screenshot of an appointment entry](image)

The entry displays on the calendar with the bell to indicate a reminder is set, and the key to indicate this is a private appointment.

The **location** appears next to the **house** icon and the **subject** of the appointment is displayed.

If you have granted permission for another person to see your calendar entries, only you will see the details of an entry that you mark “private.” See information on **Private Calendar Entries** on next page.
Private Calendar Entries

If you plan to share your calendar with another user (you must grant special permission to do this—no one can see the contents of your calendar unless you set up the permission), you may want to mark some of your entries as “private.” Use the checkbox next to Private to prevent anyone who shares your calendar from seeing the details of a specific appointment.

If you do not grant permission for anyone else to see your calendar, no one else will be able to see any of the details of your calendar. The only information available to other people is called free/busy time, which is available to people who are trying to schedule meetings. This facilitates planning meetings because it displays color-coded bars to indicate whether people are free or are busy. By default, two months of free/busy time are displayed for users. See the section on Inviting People to a Meeting to learn more about the free/busy feature and how it is used for scheduling meetings.

When you mark a calendar entry as private, you will see the details of the entry on your own calendar. Anyone who shares your calendar will not see the details, but will see that something is on your calendar for that time slot. See example below.

![Image of calendar entry]

Your view  View for person with whom you share calendar

Remember, no one sees the details of your calendar unless you specifically grant that permission. See more information under Sharing Calendars.
ADDING AN ALL DAY EVENT TO YOUR CALENDAR

Navigate to the date of the event and double-click on the date heading on your calendar, rather than on a time slot. Outlook will understand that this is meant to be an All Day Event, and that box will be checked. Notice that there are no start or end times, just dates. An All Day Event may stretch across several days. You may select a different date for the end time.

In this case, finals week is Monday through Friday, so the calendar button at the end time is clicked to produce a calendar. Click on the date the event will end.

Note that the time will be displayed on the calendar as “free” time, meaning you will not be marked busy for the entire duration of this event, which is Monday through Friday.

By default, a reminder is set, but for All Day Events, you typically uncheck that box so you don’t get a reminder of this event.

Click on the Close and Save button in the upper left corner of the window.

The All Day Event will appear as a banner across the top of the day or days of the event.
ADDING A RECURRING APPOINTMENT OR MEETING TO YOUR CALENDAR

Outlook saves you lots of time by allowing you to put recurring meetings and appointments on your calendar with a single entry. Some examples of recurring events would be staff meetings, committee meetings, office hours, classes that you teach, etc. These events occur on a regular basis, on the same days and times, for the same durations. Because they follow a regular pattern, these events can be placed on the calendar using just one New Appointment window.

Some recurring events have a definite end date—classes will end after 15 weeks, as will office hours.
Some recurring events will have no definite end date—staff meetings may be scheduled for once a month or once a week, always on the same day of the week and at the same time, indefinitely.

Navigate to the first date of the recurring event and double click on the time slot that the event will begin. Enter the subject and location, and indicate the end time of the event. You may opt to remove the reminder, or set it to a different time.
Next, click on the Recurrence button on the appointment window’s toolbar.
The Recurrence Dialog Window

At the Appointment Recurrence window, you will set the Recurrence Pattern and the Range of Recurrence.

There are many possible recurrence patterns: daily, weekly, monthly and annually. Each pattern has its own possibilities. Select the recurrence pattern from the possible choices.
Setting the Recurrence Pattern

This example will show the monthly recurrence patterns. Because the first occurrence is on Oct. 26, it is assumed that you may want this to occur on the 26th day of each month. If that is not the case, click on the radio button below that to select a different pattern.

The options for monthly recurrence include the 1st, 2nd, 3rd, 4th, or last day of the month. Options for the day include day, weekday, weekend day, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday or Sunday.

For this staff meeting, the last Friday of each month is set as the recurrence pattern.

Range of Recurrence

If this event will end by a specific date, or after a certain number of occurrences, indicate that in the Range of Recurrence section. You may type in a number of occurrences, or click on the calendar button beside the End by: heading to select a specific date.

If this event will continue into the future with no end date in sight, just leave the default as No End Date. When finished making your selections, click on the OK button.
The New Appointment window reappears and indicates the recurrence pattern you set—it is shown in the middle of the window, beside the Recurrence heading. In this case, the meeting will occur on the last Friday of every month. Click on the Save and Close button to save this recurring meeting and place it on your calendar.

The entry will appear on the last Friday of each month, at the 10:00-11:00 time slot. If you navigate ahead on your calendar to future months, you will see the entry for the recurring meeting. Note the double curved arrow icon that indicates this is a recurring meeting.
INVITING PEOPLE TO A MEETING

This feature uses both the calendar and e-mail. It works with other people who are using Outlook and the same Exchange server that you use. If you invite people who are not on the Exchange server, and/or who do not use Outlook, they will simply get an e-mail message and will only see the information that you type in the body of the invitation.

On your calendar, navigate to the date and time that you want to hold the meeting and double-click on the time slot. Type in the subject and location and select the end time for the meeting. Type in a message in the body of the dialog window. This is the information that will appear in the e-mail invitation that is sent out.

Notice the blue banner that says, “To invite other people to this meeting, click Invite Attendees.” Click on that button to invite people. See next page for inviting attendees.
Invite Attendees

After clicking on the Invite Attendees button, a To field will display. You can click on the To button to select names from the Global Address List (GAL), or you can type in the names, separated by semicolons, and click on the Check Names button to check their names in the GAL.

Now you see a blue banner that says, “To see when attendees are free and busy, click Planner.”

Click the Planner button and you will see a planning screen.
Planner Window

At this window you will see the names of the people you plan to invite. If there is a red “X” beside a person’s name, it means that person is not free at the time you want the meeting. The blue vertical bars on the Planner indicate the times that YOU are not available. The gray vertical bars indicate the times that at least one of the other people is not available.

You can click on the check mark beside a person’s name to remove the gray bars that designate the busy times for that person. Replace the checkmark to display the gray bars for that person’s busy time.

The purpose of the planner is to help you determine whether people are available for a meeting or not. Since it is difficult to find times when everyone is available, the red X’s will show you how many people are NOT available and will help you decide on a time that will work for most of the people you want to invite.

If you reach this point and decide you want to include more people in the meeting, you may click on the Invite Others button to select names from the Global Address List or from your Contacts list.
**Auto Pick**

The *AutoPick* button will look for the next time slot that all people are available for the duration you need for the meeting (one hour, two hours, etc.). The **light aqua blue** area is the time slot you are initially requesting. (Identified in the example below with a black outline.) If you click *AutoPick*, that blue block will move to the next available time slot that everyone is free.

You can also **drag your mouse across** a different time slot to select it.

Once you have found a suitable time, click on the *Choose Time* button.
New Time Found by AutoPick

By using the AutoPick button, a new time was found when all attendees would be free. After clicking on the Choose Time button, you will be returned to the Invite Attendees window. You will see that the date of the meeting has changed to Nov. 1. Make any adjustments you want to the body of the message and click on the Send button.

The invitation will be sent as an e-mail message. When it arrives in the attendees’ inboxes, it will have a meeting icon to identify it as a meeting invitation.

When viewed in the Preview Pane, the message displays the Location of the meeting and When the meeting will take place. However, the response buttons do not display in the Preview Pane. The message must be opened in a separate window to display the response buttons.

Note that if you send this message to someone who is not using Outlook, the Location and When fields will not display. If you plan to invite non-Outlook users, you will need to state the meeting date, time and location in the body of the e-mail message before you send it.
Responding to a Meeting Invitation

When the attendee opens the e-mail message in a separate window (not in the Preview Pane), response buttons will appear, enabling the attendee to accept, decline, or tentatively accept the invitation.

Notice the yellow banner that tells the user—
“No conflicts were found for this meeting. To accept it, click Accept.”

Even though you know there are no conflicts for that time slot, you can click on the Calendar button here to look at the surrounding times on your calendar for that day before responding to the invitation.

Clicking on the response buttons initiates these actions:

- **Accept** Sends a response to the meeting organizer that you have accepted the invitation. Places the meeting on your calendar automatically, and marks that time slot as busy. Deletes the message from your Inbox.

- **Tentative** Sends a response to the meeting organizer that you have tentatively accepted the invitation. Places the meeting on your calendar but marks it as tentative, with a light blue vertical bar. Deletes the message from your Inbox.

- **Decline** Sends a response to the meeting organizer that you have declined the invitation. Does not put anything on your calendar. Deletes the message from your Inbox.
**Accepting a Meeting Invitation**

After you click on the *Accept* button, you will have the options of simply sending the acceptance response, or of typing in some comments to go along with the response. To send the response, you need to click on the *Send Response* button. After you accept the meeting, the invitation will be deleted from your *Inbox* and the details of the meeting will automatically be placed on your calendar. In this example, some comments were added to indicate that the attendee would be arriving a little late.

![Accepted Meeting Invitation](image)

**Declining a Meeting Invitation**

Click on the *Decline* button and you will see the option of simply sending the declination, or of typing in some comments to go along with the response. Add comments if you wish, and then click on the *Send Response* button. After you send the declination response, the invitation will be deleted from your *Inbox* and the item will NOT be placed on your calendar.

![Declined Meeting Invitation](image)
Checking Status of Meeting Responses of a Meeting You Organized

When you invite people to a meeting, you are considered the meeting organizer. As the organizer, you may go to your calendar and double-click on the meeting entry to see a breakdown of responses from attendees. You will see a list of all the attendees and an indication of their responses.

Checking Status of a Meeting Invitation That You Accepted

When you are an attendee of a meeting to which someone else has invited you, once you accept the invitation, you can open the entry on your calendar and see the other invitees. Note that you see the name of the organizer, the required attendees and the optional attendees (if any). You will not see their responses, but you will see the date and time you sent your acceptance.
REVISING CALENDAR ENTRIES

Changing the Meeting Time for a Meeting You Organized

Go to the calendar entry for the meeting and double-click on it. Click on the *Update Meeting* button. A new window will appear, displaying all the fields of the meeting. Make any changes you need and click on the *Send Update* button. All attendees will receive an e-mail update and will be able to respond to the new request.

Editing an Existing Single Entry

Double-click on the vertical bar of the calendar entry to open it. Type in any changes and click on the *Save and Close* button in the upper left corner of the window.

Deleting an Existing Single Entry

Hold down the *CONTROL* key and click on the calendar entry. From the pop-up menu, click on *Delete*. The entry will be deleted. Another method for deleting calendar entries is to click on the entry to select it and then from the *Edit* menu, select *Delete*.

Deleting a Single Occurrence of a Recurring Event

Hold down the *CONTROL* key and click on the entry. From the pop-up menu, click on *Delete*. A window will pop up asking if you want to delete ALL the occurrences of this recurring event. The default is to respond with *No*, and to delete only the one instance. Click on the *No* button and only the one entry you selected will be deleted. All other occurrences of this recurring event will remain on your calendar.

Deleting All Occurrences of a Recurring Event

Hold down the *CONTROL* key and click on the entry. From the pop-up menu, click on *Delete*. A window will pop up asking if you want to delete ALL the occurrences of this recurring event. In this case, you do want to delete ALL of them, so click on the *Yes* button.
Changing a Single Occurrence of a Recurring Event

Hold down the *CONTROL* key and click on the entry. From the pop-up menu, click on *Open*. Make the change and click on the *Save and Close* button in the upper left corner of the window. Only the single entry will be changed. All other instances of the recurring event will remain the same.

Changing All Occurrences of a Recurring Event

Hold down the *CONTROL* key and click on the entry. From the pop-up menu, click on *Open*. Click on the *Edit Series* button on the appointment window toolbar. At the next window, click on the *Recurrences* button on the appointment window toolbar. Make the changes and click on the *OK* button. At the next window, click on the *Save and Close* button. All occurrences of the recurring event will show the changes you made to the series.

Moving a Calendar Entry

You can drag a calendar entry by its vertical bar on the left side of the entry, and drop it to another day and time slot that is visible on the calendar, or you may open the calendar entry and change the date and time, which will move it to the new location on the calendar.
PRINTING CALENDAR ENTRIES

With the calendar displayed, click on the File menu and select Print. At the print dialog window, make your selections for the date range you want to print and for the style you want to print. You can click on the Preview button before you print.
CALENDAR PREFERENCES

You may change some of the calendar settings by clicking on the *Edit* menu and selecting *Preferences*. Click on *General* under the *Calendar* heading.

![Outlook Preferences dialog box](image)

**Week and Work Day Settings**
You select the day your week starts (default is Sunday) and your work day hours.

**Calendar Time Scale (Increments)**
The default time increment on the calendar is 30 minutes. You can use the spinner buttons to change the *Time Scale Settings* from the available options of 5, 6, 10, 15, 30, or 60 minutes.

**Meeting Requests**
Note that the default is to delete meeting requests from your *Inbox* after you respond to them. You may change that option to keep the messages in your *Inbox* even after you’ve responded to them.

**Free/Busy Time**
By default, 2 months of your free/busy time is available on the server so other people may schedule meetings with you. You can increase this by typing a different number in the field.

After you’ve made any desired changes, click on the *OK* button to confirm the new settings.
Reminders Settings

You can click on Reminders under the Calendar heading to set your defaults for reminders.

Sound

You can change the sound that plays when a reminder appears, or you can turn off the sound altogether.

Reminder Time Prior to Appointment

You can use the spinner buttons to set the default reminder time to a specific number of minutes, hours, days, or even weeks prior to a calendar entry. You may type in a number if the number doesn’t appear in the spinner button list.

Default Reminder Time for Tasks

You can also set the default reminder time for your Tasks. The default is set to 8:00 AM of the task’s due date, but you may change it to any time, on the due date, in half hour increments.
SHARING CALENDARS

You may want to be able to view another person’s calendar and perhaps enter appointments and meetings on his/her calendar. To do this, that person must first grant you permission. Both of you must be using Outlook and must have account on the same Exchange server.

GRANTING PERMISSION FOR SOMEONE TO VIEW AND/OR UPDATE YOUR CALENDAR

Open Outlook on your own computer. Go to the Edit menu and select Preferences. Under the Microsoft Outlook category, select Sharing. Click on the Add button to add the person you want to view and/ or update your calendar. Select the person from the Global Address List. Click on the Add button and then click on the OK button. You will be returned to the dialog window below. Click on the person’s name that you’ve just added and follow instructions on next page.
Permission Level

After indicating the person to whom you are granting permissions, you will set the level of access you want that person to have. There are three basic levels you can choose from this screen:

EDITOR: can read, create and modify items
AUTHOR: can read and create items
REVIEWER: can read items

To grant permissions, first make sure the person’s name is selected. Then use the spinner buttons beside the component to which you are granting permission (Calendar, Inbox, etc.) and select the level of permission you want to grant.

You can also indicate other permissions. There are checkboxes to allow the person to send e-mail on your behalf, to see your calendar items that you have marked “private” and to make this person a delegate who will receive copies of meeting requests that are sent to you. However, only Editor permission will allow a person to become your delegate. If you make a person your delegate, you can also indicate that meeting requests be sent ONLY to the delegate and NOT to you. There is more information about this in the Delegate Access section of the manual.

It is a good idea to check the box to Send this person a summary of these permissions.

When finished with all selections, click on the OK button.
Alternate Method of Setting Permission Levels

There is another way to set permissions, but it doesn’t display all the options you see on the previous dialog window.

To view these permissions, hold down the CTRL key and click on the Calendar button on the Outlook Bar. Then click on Properties and then click on the Permissions tab.

![Calendar Properties](image)

Use the Add button to add the person and then click on the spinner buttons for the Roles and you’ll see more roles. You can also simply select the permissions that you want to grant by clicking in the checkboxes. Then the role will be considered “Custom.” Click on the OK button when finished making selections.
Making Mailbox Folder Visible

Another step you will need to complete will enable the other user to create an icon for your calendar on his/her Outlook Bar.

Make sure your Folder List is displayed. (From the View menu, click on Folder List.)

Hold down the CTRL key and click on the Mailbox icon.
From the pop-up menu, click on Properties.
Click on the Permissions tab.
Click on the Add button and add the other person. Make sure the name is selected.
Click in the checkbox to make the Folder Visible.
Click on the OK button.
ACCESSING ANOTHER PERSON’S CALENDAR

Follow these steps to enable viewing another person's calendar after you have been granted permission to the calendar.

From the Tools menu, select Services and then at the dialog window, click on the Properties button.
At the next dialog window, click on the Advanced tab. Click on the Add button.
Type in the person's User ID or part of his/her name. Click on the OK button. If there is only one matching name it will pop in. Click on the OK button on that dialog window.

(If there is more than one matching name, you will see all matches and you can select the one you want, click on the Change button and then click on the OK button at the next dialog window.)

**Viewing the Other Person's Calendar**

To see another person’s calendar, click on the File menu and select Open and then select Other User’s Folder. You can click on the Name button to go to the Global Address List to select the person's name, or simply type in the name.

Indicate which folder you want to open. The Open button will be activated so you can click on it.

This is a rather tedious method of viewing the person’s calendar, so you may want to add a shortcut icon to your Outlook Bar. Before you can do this, the other person must have given you permission to view his or her Mailbox folder (see instructions on Making Mailbox Folder Visible a few pages back in manual).
Creating a Shortcut Icon for Accessing Another Person’s Calendar

Open Outlook and display the Folder List. (From the View menu, select Folder List.) A mailbox icon for the other person should appear in your Folder List display. There should be an Expand button in front of it. Click on the Expand button beside the Mailbox icon and you should see an icon for the other person’s calendar. Drag this icon to the Outlook Bar.

Hold down the CONTROL key and click on the calendar icon that you just dragged to the Outlook Bar. From the pop-up menu, click on Rename Shortcut. Type in the other person’s name so you can distinguish between the two calendar icons that are now on your Outlook Bar. Press the Return key.

Take care when selecting the other person’s calendar icon. The calendar doesn’t display with the other person’s name in the Folder Banner.

Depending on the level of permission you have been granted you may be able to view, add, edit and/or delete items on the other person’s calendar. Changes you and the other person make are stored on the server.
DELEGATE ACCESS

You may want to allow another user to be your delegate. You may allow this person to:

1. Send e-mail messages on your behalf
2. Send meeting requests on your behalf (must have Editor rights to your calendar)
3. Receive a copy of meeting requests that are sent to you
4. Receive all meeting requests that are sent to you, (but have the requests bypass your Inbox and go ONLY to the delegate's Inbox)
5. View your Private Items

You do not need to give ALL these permissions to your delegate. You can decide which permissions to grant. The options are found at the dialog window below.

To give someone else delegate access to your account, click on the Edit menu and select Preferences. Under Microsoft Outlook, click in the Sharing radio button. Use the Add button to find the other person in the Global Address List. Add the person and click on the name. Indicate all privileges you want to grant by using the spinner buttons by the components (Calendar, Inbox, etc.) and by checking any of the boxes that give special privileges. Click on the OK button when you finished making all your selections.
**SENDING MESSAGES ON BEHALF OF ANOTHER PERSON**

You must have been granted delegate privileges by the other person before you may send messages on his/her behalf.

In this example, the Dan Trainer account has been granted delegate privileges by Karen Wenz. These privileges allow Dan Trainer to send e-mail messages on behalf of Karen Wenz.

Dan Trainer logs in as himself and opens a new message window. From the View menu, he clicks on *From field*. This displays a *From: field* in the new message window. He types Karen Wenz in the *From* field and then addresses the message to Gordon Schmitt. He types the messages and sends it.

When Gordon Schmitt opens the message, it looks like this, clearly indicating that the message is from Dan Trainer, sent on behalf of Karen Wenz.
REQUESTING A MEETING ON BEHALF OF ANOTHER PERSON

You must first have been granted Editor rights to the other person’s calendar.

In this example, the Karen Trainer account has been granted Editor rights to Karen Wenz’s calendar. These privileges allow Karen Trainer to request meetings on behalf of Karen Wenz.

Karen Trainer logs in as herself and opens Karen Wenz’s calendar. She selects a time slot and creates a meeting request, sending it to Dan Trainer and Gordon Schmitt. When the message is received by Gordie and Dan, it looks like this in the Inbox, but when the message is opened, it clearly identifies the request as sent on behalf of Karen Wenz.

Inbox View

![Inbox View]

Opened Message View

![Opened Message View]

When Dan and Gordie respond to the meeting request, the responses are sent to Karen Wenz.
TASKS

Tasks are basically electronic “To Do” lists. You can describe the task and set a deadline for completing the task. To create a new task, click on the drop-down button by the New button and select Task.

At the dialog window, type in the details of the task:

![Task Dialog Window]

Note that a reminder is automatically set for 8:00 a.m. on the due date. If you need to be reminded earlier than that, change the reminder date and time. You can set a priority for the task—normal, high, low.

There is a recurrence button, so you may use this for any tasks that recur on a regular basis—monthly or quarterly reports that you must complete, inventories, etc.

Note that there are lots of things you can track with the task—including the number of hours the task takes, and any mileage or billing information. You may not need all these details, so just use the fields that are relevant to your task.

When finished with all details, click on the OK button.
**Task List**

Your tasks will appear in the Task list, displaying the subject and the due date.

The ✓ column indicates whether the task has been completed.

Tasks that appear in red typeface are **overdue**.
Tasks that appear in black typeface are **not completed**, but are not yet overdue.
The bell alarm symbol indicates that a **reminder** is set for that task.
Tasks that appear in gray typeface with overstrike are **completed** tasks.
A ✓ also appears before a **completed** task.

When you have completed a task, and marked it completed, it remains in the task list until you delete it.

Your tasks are displayed by clicking on the Task button on the Outlook Bar.

You may change the way you view your tasks. From the View menu, click on Tasks View and you may select from these options:

Below these views, you may check whether you want to **Include Tasks With No Due Dates**. The default is to include them.
TASKS IN CALENDAR VIEW

Tasks are also displayed in the Calendar view—in the lower right corner of the window.
TASKS VS. CALENDAR ENTRIES

Tasks and Calendar Entries are actually somewhat similar, but there are differences that you should consider when determining whether it’s more appropriate to place an item on the calendar or on the task list.

Tasks

- Use Tasks to make lists of tasks you need to complete
- Tasks allow you to see the list daily and to help keep you on track
- Tasks serve as reminders of things you need to accomplish
- The Task list appears in a concise format
- Tasks allows you to set deadlines for completion, and allows you to set reminders

You cannot designate specific time blocks in which to complete tasks.

Calendar Entries

- Calendar entries allow you to schedule time blocks on your calendar to complete tasks
- This helps you to manage your time to ensure that you complete projects within designated time frames.
- Calendar entries do not allow you to see your projects and tasks in a concise format

Based on this information, you can decide how to enter your tasks and projects. You may decide to enter some things on both the Task list and the Calendar.
OWA OUTLOOK WEB ACCESS

Because your e-mail, calendar, task, journal, notes and contact entries are stored on the server, you are able to access those folders via a Web interface. You may use any computer that is connected to the Internet and that has a Web browser installed. Using a Web browser to access your account is referred to as the Outlook Web Access or OWA. You may use Internet Explorer or Netscape, but the visual interfaces differ somewhat. The examples in this manual are for OWA from Internet Explorer.

To use OWA from on campus, type in “huskynet” (without the quotes) at the address bar. From off campus, type in “http://huskynet.stcloudstate.edu” (without the quotes) and click on the link for Check E-mail.

If you see any dialog windows that ask about a certificate, simply respond in the affirmative (Yes, Next, OK, etc.) so that you may continue to move towards the sign on screen.
SIGNING ON TO OWA

At the sign on screen, type in your Huskynet ID and password.

If you see a checkbox to “Remember Password.” DO NOT check it. You do not want your password saved, because that means anyone could go to that computer and get in to your account without knowing your password.

The Web interface is somewhat different from the desktop client interface (using Outlook 2001 on your personal computer), but the look and feel are the same. The differences between the desktop client and the web interface are detailed on a Helpdesk Web site http://www.stcloudstate.edu/help/faqs/outlookfeatures.html

You may use this interface when you are away from your office. You may read and send messages, create calendar entries and do many, but not all of the things you can do from the desktop client.

IMPORTANT NOTE ABOUT CLOSING OWA INTERFACE

Closing OWA

You must close the browser after viewing your account. There is no “logout” button. Closing the browser means closing every window associated with the web browser. The most efficient way to do this is to Quit the browser application. From the File menu, select Quit.
**OWA Inbox View**

The web interface looks like this. Note that since this is a Web browser, it has its own title bar, toolbar, address bar and favorites bar. The buttons you may use to maneuver in the Outlook component (*Inbox, Calendar, Contacts*, etc.) are on this toolbar, shown in two different rows because it is too long to fit across the page:

Note that the OWA toolbar is context-sensitive, and will display buttons appropriate to whichever component is selected. In this case, the *Inbox* is selected, so these buttons relate to the *Inbox*.

In the OWA interface, the items in your folders are divided into pages, with 25 items per page. If you have more than 25 items in a folder, a page navigator will be displayed in the upper right corner of the OWA window. Use the forward or back arrow buttons to move from page to page, or simply highlight the page number and type in a number, and press the *Return* key.
**INBOX TOOLBAR**

*New* button with spinner buttons to select new item (message, appointment, contact, etc.)

- *Move* up a level
- *Refresh* the view
- *Move* the selected message
- *Copy* a message
- *Rename* the selected item
- *Delete* the selected item(s)
- *Empty* the Recycle Bin

**Select a View for Messages:** (All) Messages, Unread Messages, By Sender, By Subject, By Conversation Topic, Unread by Conversation Topic, Sent To.

**Search Global Address List** (launches the *Find* dialog window)

- Displays *Public Folders*
- Displays online *Help* for Outlook Web Access

**Page Navigator** in the *Inbox* of OWA divides your messages into pages, with each page displaying up to 25 messages. The *Page Navigator* only displays if your *Inbox* currently contains more than 25 messages. Use the arrow buttons to move one page ahead or back, or highlight the number and type in a page number and press the *Return* key to move to a specific page.
**SENDING A MESSAGE VIA OWA**

On the toolbar, use the spinner buttons by the *New* button to select *Message* and then click on the *New* button. At the *New Message* window, type in part of a person’s name. Then click on the *Check Names* button on the toolbar. The *Global Address List* and your *Contacts* will be searched (in whichever order you have set as your preference).

If only one matching name is found, that person’s full name will be displayed *above* the *To* field.

If more than one match is found, the name you typed will appear in red typeface and a message will display that says a recipient was not recognized. Click on the name and you will see a display of all the people whose names matched what you typed.

From the list of names, click in the radio button beside the name you want to use.

Indicate where you want the recipient’s name to go (in the *To*, *Cc* or *Bcc* field) and click on the *Apply* button in the upper right corner of the window.

Note that you cannot view the entire *Global Address List* via OWA. You need to use the *Check Names* button to search the list.
At the New Message window, you can select the level of importance for the message, and whether you want a read receipt, delivery receipt, both or none. Type in a subject and type the message in the message field. When finished with any other options (including a file attachment, for example), click on the Send button.

Removing Names from the To: Field

If you want to remove a person’s name from the To: field, click on the person’s name and you will see this dialog window: Click in the radio button to Delete this recipient from the list.

Then click on the Apply button in the upper right corner of the window.
Including a File Attachment

To insert a file attachment, in the New Message window, click on the paper clip button.

1. Use the Browse button to locate the file you want to attach. Navigate to the location where the file is stored, and click on the filename and click on the Open button. The filename will appear in the white box beside the Browse button.

2. Click on the Attach button and the filename will appear under the Current File Attachments heading. Follow the same steps to add more attachments if necessary. If you already typed your message, you can click on the Send button here, or click on the Go Back To Message to complete the message before sending.

After you’ve clicked on the Attach button, the name of the file attachment will be listed at the bottom of the window. If you change your mind about attaching a file, you can click the checkbox beside the filename and click on the Remove button.
READING MESSAGES IN OWA

To navigate through the messages in your Inbox, click on a message. The message opens and displays a toolbar. The buttons without text are labeled here:

Move   Copy   Previous Next Delete

Navigate through the messages by using the Previous and Next arrow buttons. Respond to messages using the Reply and Forward buttons. Use the X button to delete the currently displayed message. Use the Close button to close the message window.

Update the Inbox View

When you use OWA to view your e-mail, new messages that are sent to you after you’ve logged on do not automatically appear in your Inbox.

Click on the Refresh button to display new messages that have been sent to you since you logged on.

Deleting Messages

When you delete messages in the OWA interface, the messages are moved to the Deleted Items folder. Click in the checkboxes beside messages you want to delete and then click on the Delete button.

Displaying the Deleted Items Folder

You may display the Deleted Items folder by clicking on the Folders button on the OWA Outlook Bar and then clicking on Deleted Items (the words, not the icon).

Emptying Deleted Items Folder

There is a button on the OWA toolbar that empties the Deleted Items folder. Click on it once to empty the Deleted Items folder.
**OWA CALENDAR TOOLBAR**

Use the spinner buttons to select a new Appointment, Message, or Folder.

- Move up a level
- Refresh the view
- View [Daily] Use the spinner buttons to select the Daily or Weekly calendar view.
- Search Global Address List (launches the Find dialog window)
- Public Folders Displays Public Folders
- Displays online Help for Outlook Web Access

**DISPLAY CALENDAR IN OWA**

Click on the Calendar icon on the Outlook Bar to display the calendar. Use the Date Navigator to display the date you want. Note that the only views available in OWA are Daily and Weekly.
Creating a Calendar Entry in OWA

To create a new entry on the calendar, you cannot simply double-click on a time slot. Navigate to the date and then use the New button to select a new appointment. At the dialog window, type in the details of the appointment—the subject and location.

(You don’t need to type anything in the Required, Optional and Resources fields unless you are inviting people to a meeting.)

<table>
<thead>
<tr>
<th>Required:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional:</td>
<td></td>
</tr>
<tr>
<td>Resources:</td>
<td></td>
</tr>
<tr>
<td>Subject:</td>
<td></td>
</tr>
<tr>
<td>Location:</td>
<td></td>
</tr>
<tr>
<td>Attachments:</td>
<td></td>
</tr>
<tr>
<td>□ Request Responses</td>
<td></td>
</tr>
<tr>
<td>Start time:</td>
<td>November 30 2001 3:30 PM All day event</td>
</tr>
<tr>
<td>End time:</td>
<td>November 30 2001 4:00 PM</td>
</tr>
<tr>
<td>Show time as:</td>
<td>Busy</td>
</tr>
</tbody>
</table>

Indicate the start and end times. Use the spinner buttons to indicate how to show the time (busy, free, etc.).

When finished entering all the details, click on the Save button.
**nda Contacts Toolbar**

Use spinner buttons to create new Contact, Message, Appointment or folder.

- **Move** up a level
- **Refresh** the view
- **Move** the selected contact to another folder
- **Copy** the selected contact to another folder
- **Delete** the selected item(s)

**View Address Cards**

Use the spinner buttons to view the contents of the Contacts folder as Address Cards, Detailed Address Cards, Phone List, By Company, By Location, or By Follow Up Flag.

Notice that distribution lists will display in the Contacts in OWA, but you are not able to open them or use them in the OWA interface.

### Contacts

- **Aug 7 PM Class**
  - Benner, Jane
  - E-mail: Jane Benner
- **Board of Directors**
  - Breckenridge, Howard
  - E-mail: Howard Breckenridge
- **Bugs Bunny**
  - E-mail: Bugs Bunny
- **Bunny, Bugs**
  - E-mail: Bugs Bunny
- **Christians, Tina M.**
  - E-mail: Tina M. Christians
- **Fitness Class Leaders**
- **Flanders, rhonda**
  - E-mail: rhonda Flanden
- **Friends**
- **GMW July 25 Day**
Using Contacts in OWA

Individual contacts may be used by typing part of the contact’s name in the To field in a message and then clicking on the Check Names button.

Another option is to click on the Contacts icon on the Outlook Bar and open the contact entry. Then click on the button selected here (New Mail Message to Contact). This will open a new message window, and the address for the contact will be entered in the To field automatically.

New Message Window with Jane Benner’s e-mail address in the To field.
Creating a New Contact in OWA

With the *Contacts* folder displayed, click on the *New* button. A screen similar to the one in the Outlook Desktop Client will appear. Type in the details for the contact and click on the *Save* button.

![Contact Creation Screen](image-url)
FOLDERS

Click on the *Folders* icon on the *Outlook Bar* to display all your folders. Click on a folder name to display its contents.

When a folder displays, if it has subfolders, you will see a + plus symbol button beside the folder name. Click on the + button to display the next level of folders.

![zzKaren Trainer]

Then use the *Up one Level* button to collapse the level.
OPTIONS

Click on the Options button on the OWA Outlook Bar to see the options you can set via the web interface.

Some of these options are the same as the ones you can set on the Desktop Client, using the Preferences from the Edit menu.
CHANGING THE PASSWORD

Choosing a Password

Your new password needs to be a minimum of 6 characters long and may contain alpha and/or numeric characters only. For faculty and staff, it must be changed every 180 days, or approximately twice a year. For students, it must be changed once a year.

Steps to Change Password

You must use a web browser to change your password.

You may go to the [http://huskynet.stcloudstate.edu](http://huskynet.stcloudstate.edu) page and click on the *Change My Password* link. This takes you directly to the *Change Password* window.

OR

After you have logged into the OWA interface, you may click on the *Options* button on the *OWA Outlook Bar*. Scroll down to display the *Password* option and click on the *Change Password* button. This takes you to the *Change Password* window.
Change Password Window

Type in all the information and then click on the *Change My Password* button. Note that HuskyNet ID is the term used for the User ID that allows you access to SCSU resources, including SCSU e-mail.

If you see a *Password changed successfully* message, your new password is established. If you see any other message, you will need to go through the password change procedure again.

If you have difficulty with the password change, you may call the Helpdesk for assistance—255-2077.
FORGOTTEN PASSWORD

There is a special customized feature to help you change your HuskyNet password if you have forgotten your current password. This procedure is performed via the Web browser.

It requires that you know:

1. Your Tech ID number (displayed on your SCSU identification card, or available from the Human Resources office—255-3203). The Tech ID number is eight digits long. Many of the Tech ID numbers have leading zeroes (i.e., 0000372). If you see an extra leading zero on your SCSU ID card, disregard it and just use the last eight digits of the ID number that are displayed on your card.

2. Your SCSU PIN (Personal Identification Number). This is the number you use to access the online registration screen to register for classes and/or display your class lists. If you are unfamiliar with this PIN number, be advised that by default, the PIN is your birthdate in this order: YYMMDD. If you were born on May 21, 1952, your default PIN would be 520521. If you have already used your PIN number and changed it to something else, make sure to type in the current PIN number.

Steps to Change Password if You’ve Forgotten Your Password

If you have forgotten your password, obviously you cannot log on to your account. Using Internet Explorer, go to the [huskynet.stcloudstate.edu](http://huskynet.stcloudstate.edu) web page. Scroll down the page until you see a link on the left that says Change My Password. Click on it to be taken to the Change Password dialog window. Click on the link shown here.

Forgot your password? [Click here.](#)
Forgot your password?

To reset your password you will need your 8 digit Tech ID, PIN, and birthdate. After you have entered this information, click on “Submit Information” and you will be prompted to enter a new password.

Please enter your 8 digit Tech ID
(i.e. 00012345)

Please enter your PIN
(If you have not reset your PIN, the default will be: yymmdd)

Please enter your Birthdate
(yymmmddd)

Submit Information

Type in your Tech ID number, PIN and birthdate in yyyymmddd order (May 21, 1952 would be entered as 19520521) and click on the Submit Information button. If you entered all three items accurately, your password will be reset and you will be able to type in a new password and confirm it.

If this process does not work for you, you will need to call the Helpdesk at 255-2077 to request that a server administrator or technical person reset your password for you.

**Closing OWA**

This is repeated because it is very important. You must close the browser after viewing your account. There is no “logout” button available. Closing the browser means closing every window associated with the web browser. The most efficient way to close the browser is to select Quit from the File menu.
Recovering Deleted Items via OWA

Under the options in OWA, you may recover deleted items. These are not items that are currently in your Deleted Items folder. These are items that have been deleted from that folder. This recovery is only available via OWA—you are not able to do this from the Outlook desktop client. It is only possible to retrieve things that were recently emptied from the Deleted Items folder.

After clicking on the Options icon on the Outlook Bar, scroll down until you see this option. Click on the View Items button.

Click in the checkbox beside any items you want to retrieve, and click on the Recover button.

You will see a list of folders, calendar entries and messages that can still be retrieved. Note that when they are retrieved, they will simply be moved back to the Deleted Items folder.

Once items have been returned to the Deleted Items folder, you may view the contents of that folder and move items out of the Deleted Items folder into your Inbox or other folders.

This is a last ditch effort to retrieve items that have been emptied from your Deleted Items folder. Note that not all items will be recovered. You may see some items listed that you try (but fail) to recover.
PUBLIC FOLDERS

The Exchange server environment at SCSU has some public folders that you may access. There will be some folders within this structure that are made available to all users. Others will be available only to specific departments.

The Public Folder feature allows people to easily share files with other people who are using the same server. Some departments will want to make forms available to everyone on campus. Other departments will want to share files only within their own departments.

The entire structure is still in the planning stages at this point. The current structure has a limited number of folders, but this will increase as more departments request folders.

To view the Public Folders, you need to display the Folder List. From the View menu, select Folder List. Use the Collapse/Expand buttons to see different levels of folders. Click on a specific folder to display its contents.

You will not have access to all the folders you see. If you click on a folder and see a message that says you need additional permission to open the folder, it is simply a folder that is limited to a particular department or group of people.
SCSU-ANNOUNCE AND SCSU-DISCUSS FOLDERS

Display the Folder List and click on the button beside Public Folders to expand it (if necessary). Expand All Public Folders, and Faculty Staff Discussions so you can see the folders for SCSU Announce and SCSU Discuss. Click on one of the folders to display its contents.

The messages that are posted to those two listservs are copied here for your convenience. You may read them at your leisure, regardless of whether you are subscribed to the listservs. The messages are kept in these folders until they are more than 30 days old—then the older messages are removed. You may simply view the messages that are stored in this folder. You may not delete them, since you have View Only rights to these folders.
Displaying Number of Unread Messages from SCSU Listservs

Outlook/Exchange will actually keep track of which messages you have read from these two listserv folders. This can be convenient for you if you want to unsubscribe from the lists and simply check the Public Folders when you have time to read messages posted to these listservs. One very convenient way to do this is to drag the folder icon from the Folder List and drop it on the Outlook Bar.

A number appears beside the icon on the Outlook Bar. The number indicates how many messages you have not read from that folder. To reduce the number to zero, scroll through all the messages in the folder.

This allows you to see, at a glance, whether there are any new messages posted to the listserv.
Replying to a Message sent to the Listserv

If you want to send a reply to a message on the listserv, select the message and click on the Reply button. This will send the reply to the person who posted the message (not to the entire listserv).
If you also want to send the reply to the listserv, make sure you type in SCSU-Announce@stcloudstate.edu or SCSU-Discuss@stcloudstate.edu in the CC field.

Posting a Message to the Listserv

Use the standard method to post a message to the listserv—create a new message and type in the listserv address in the To field. The message will be posted to the listserv and will be sent to all subscribers of that listserv. A copy of your message will also appear in the listserv folder on the Exchange Public Folders.

Posting to the Folder Only

When one of the listserv folders is displayed in Outlook, the New button changes its buttonface to New Post. If you click on the button, you will simply be posting a message into this folder. It will not be sent to all the subscribers of the listserv.

If you want your message to reach all users who are subscribed to the listserv, make sure to address your new message to the listserv address as shown above in the To field in the new message window.
SOME NOTES ABOUT OUTLOOK 2001 FOR THE MAC

RETAINING ORIGINAL E-MAIL ADDRESS IN FORWARDER MESSAGES

If you receive a message from someone who is not on the Exchange server, you will see the e-mail address of the person who sent the message, along with any personal name they include in the From field. When you forward that message to someone else, the e-mail address of the original sender is not always included in the forwarded message.

A work around for this problem is to copy and paste the original sender’s e-mail address into the body of the forwarded message, in case the person you forward the message to wants to reply to the original sender.

In original message, click on the sender's e-mail address in the From: field

![Holiday travel tips from Northwest Airlines - Message](image1)

At the dialog window, highlight the e-mail address. Then press the ⌘ and C keys to copy it. Close the dialog window.

![Northwest Airlines Properties](image2)
Click on the Forward button in the message and then position the cursor in the body of the message, after the From field, and press the ⌘ and V keys to paste the e-mail address in. Type your message and send it. The recipient of the forwarded message will see the pasted e-mail address of the original sender.

VOTING BUTTONS

Mac users can receive messages that include voting buttons. They will see the voting buttons when the message is opened in its own separate window. Mac users can reply to voting questions by using the voting buttons.

Mac users are not able to create a message that includes voting buttons.

PDAS AND SYNCHING TO OUTLOOK

If you use a PDA (Personal Digital Assistant such as a Palm Pilot), you may want to synchronize the address book and your appointments on the PDA to the address book (Contacts) and the calendar on your SCSU Huskynet account. There is currently no software that will provide this synchronization (as of 12-18-2001), but you may install Virtual PC on your Macintosh and install Outlook on the Windows/PC side of the Mac. From there, you may synchronize your PDA data to your Outlook/Exchange account.
KEYBOARD SHORTCUTS IN OUTLOOK

There are numerous keyboard shortcuts available in Outlook. For a complete list, open Outlook and from the Help menu, select Microsoft Outlook Help and click on the Keyboard Shortcuts link on the left side. On the right side, you will see a link for Printable Keyboard Shortcuts. Click on the link. A long list of shortcuts will display. If you want to print the list, from the File menu, click on Print. (Note that most help screens are NOT printable. This one is an exception.)
### KEYBOARD SHORTCUT LIST

These are just a few of the many keyboard shortcuts available in Outlook.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function or Action Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + N</td>
<td>Create a new message from anywhere in Outlook</td>
</tr>
<tr>
<td>⌘ + K</td>
<td>Check Names in New Message Window with name(s) typed in To field</td>
</tr>
<tr>
<td>⌘ + ENTER</td>
<td>Send the current new message (with new message window open)</td>
</tr>
<tr>
<td>⌘ + R</td>
<td>Reply to a message (with the message open or selected)</td>
</tr>
<tr>
<td>⌘ + SHIFT + G</td>
<td>Flag a message for follow-up (with message open or selected)</td>
</tr>
<tr>
<td>⌘ + G</td>
<td>Go to a specific date on the calendar (with calendar displayed)</td>
</tr>
<tr>
<td>⌘ + W</td>
<td>Close window</td>
</tr>
<tr>
<td>⌘ + Q</td>
<td>Quit Outlook</td>
</tr>
<tr>
<td>⌘ + 1</td>
<td>Display Inbox</td>
</tr>
<tr>
<td>⌘ + 2</td>
<td>Display Calendar</td>
</tr>
<tr>
<td>⌘ + 3</td>
<td>Display Contacts</td>
</tr>
<tr>
<td>⌘ + 4</td>
<td>Display Tasks</td>
</tr>
<tr>
<td>⌘ + 5</td>
<td>Display Notes</td>
</tr>
<tr>
<td>⌘ + 6</td>
<td>Display Drafts</td>
</tr>
<tr>
<td>⌘ + 7</td>
<td>Display Sent Items</td>
</tr>
<tr>
<td>⌘ + 8</td>
<td>Display Deleted Items</td>
</tr>
</tbody>
</table>
# Outline of Topics in Manual

## Terminology in Outlook/Exchange Environment
- Exchange Mailbox Space Quota ................................................................. 7
- Attachment Size Limit ............................................................................... 7
- Filespace and Webspace Quota ................................................................. 7
- Checking Amount of Space Used .............................................................. 7
- Exceeding Your Space Quota ................................................................... 7
- Folder List .................................................................................................. 9
- Outlook Window ........................................................................................ 10
- E-Mail—Viewing the Inbox ....................................................................... 11
- Sorting Mail in the Inbox ......................................................................... 13
- About Sorting Mail .................................................................................... 14

## Server Space Quotas
- Exchange Mailbox Space Quota ................................................................. 7
- Attachment Size Limit ............................................................................... 7
- Filespace and Webspace Quota ................................................................. 7
- Checking Amount of Space Used .............................................................. 7
- Exceeding Your Space Quota ................................................................... 7
- Folder List .................................................................................................. 9
- Outlook Window ........................................................................................ 10
- E-Mail—Viewing the Inbox ....................................................................... 11
- Sorting Mail in the Inbox ......................................................................... 13
- About Sorting Mail .................................................................................... 14

## E-MAIL
- Reading Messages ..................................................................................... 15
  - Reading a Message in a Separate Window ............................................. 15
  - Reading a Message by Using the Preview Pane ..................................... 16
  - Handling Messages as They Are Read .................................................. 17
    - Replying to Messages ....................................................................... 17
    - Forwarding Messages ...................................................................... 17
    - Flagging a Message ......................................................................... 18
      - Follow Up Reminder Screen ......................................................... 19
      - Clearing or Completing a Flagged Item ......................................... 19
  - Printing a Message .............................................................................. 20
  - Deleting a Message ............................................................................. 20
    - Manually Empty the Deleted Items Folder ....................................... 20
    - Setting Delete Options .................................................................... 20
    - Retrieving Items from the Deleted Items Folder ............................ 21
    - Moving a Message .......................................................................... 22

## Technical Support
- Outlook Installation & Troubleshooting Problems in Outlook .................. 2
  - Questions about Features and Use of Outlook .................................... 2
  - Online Help .......................................................................................... 2
  - Comparison of Features on Macintosh, Windows and OWA versions .... 2
  - OWA (Outlook Web Access) ................................................................. 2
  - HuskyNet File Space and Web Space ................................................... 2
  - Acquiring and Configuring Outlook ..................................................... 2

## Terminology used in this Manual
- Spinner Buttons ....................................................................................... 3
- Checkbox ................................................................................................. 3
- Radio Buttons .......................................................................................... 3
- Toolbar Buttons ....................................................................................... 3
- Keyboard Commands ............................................................................... 4
- Dialog Window ....................................................................................... 4
- Pop-Up Menu .......................................................................................... 4
- Drop-Down List ....................................................................................... 5
- Icons ....................................................................................................... 5
- Expand/Collapse Buttons ....................................................................... 6

## Server Space Quotas
- Exchange Mailbox Space Quota ................................................................. 7
- Attachment Size Limit ............................................................................... 7
- Filespace and Webspace Quota ................................................................. 7
- Checking Amount of Space Used .............................................................. 7
- Exceeding Your Space Quota ................................................................... 7
- Folder List .................................................................................................. 9
- Outlook Window ........................................................................................ 10
- E-Mail—Viewing the Inbox ....................................................................... 11
- Sorting Mail in the Inbox ......................................................................... 13
- About Sorting Mail .................................................................................... 14
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a New Folder</td>
<td>22</td>
</tr>
<tr>
<td>Organizing Your Mail Messages</td>
<td>24</td>
</tr>
<tr>
<td>Example of Folders under an Inbox</td>
<td>25</td>
</tr>
<tr>
<td>Using Rules to Move Messages to Folders</td>
<td>25</td>
</tr>
<tr>
<td>Creating a Rule</td>
<td>26</td>
</tr>
<tr>
<td>Example of a Rule</td>
<td>27</td>
</tr>
<tr>
<td>Setting the Alert Actions</td>
<td>28</td>
</tr>
<tr>
<td>Example of an Alert Action</td>
<td>28</td>
</tr>
<tr>
<td>Examples of Rules</td>
<td>29</td>
</tr>
<tr>
<td>Change Rules</td>
<td>29</td>
</tr>
<tr>
<td>Delete Rules</td>
<td>29</td>
</tr>
<tr>
<td>Changing the Order of Rules</td>
<td>29</td>
</tr>
<tr>
<td>Suspending a Rule Temporarily/Re-establishing a Rule</td>
<td>29</td>
</tr>
<tr>
<td>Maneuvering in the Inbox</td>
<td>30</td>
</tr>
<tr>
<td>Change Options for Reading Mail</td>
<td>30</td>
</tr>
<tr>
<td>Responding to a Voting Button Message</td>
<td>31</td>
</tr>
<tr>
<td>Include Comments with a Vote</td>
<td>32</td>
</tr>
<tr>
<td>Completing the Message</td>
<td>38</td>
</tr>
<tr>
<td>Selecting a Name from a Different List</td>
<td>35</td>
</tr>
<tr>
<td>Auto Addressing</td>
<td>36</td>
</tr>
<tr>
<td>Multiple Matching Names</td>
<td>37</td>
</tr>
<tr>
<td>Completing the Message</td>
<td>38</td>
</tr>
<tr>
<td>Sending To Multiple Recipients</td>
<td>39</td>
</tr>
<tr>
<td>Signatures</td>
<td>40</td>
</tr>
<tr>
<td>Multiple Signatures and Default Signature</td>
<td>40</td>
</tr>
<tr>
<td>Creating a Signature</td>
<td>40</td>
</tr>
<tr>
<td>Changing a Signature</td>
<td>42</td>
</tr>
<tr>
<td>Using the Default Signature</td>
<td>42</td>
</tr>
<tr>
<td>Using a Different Signature</td>
<td>42</td>
</tr>
<tr>
<td>Insert a File in a Message</td>
<td>43</td>
</tr>
<tr>
<td>Sender's View of Outgoing Message Window</td>
<td>44</td>
</tr>
<tr>
<td>Recipient's View of Incoming Message Window</td>
<td>44</td>
</tr>
<tr>
<td>Security for Attached Files</td>
<td>45</td>
</tr>
<tr>
<td>Saving Attached Files</td>
<td>46</td>
</tr>
<tr>
<td>Insert an Item in a Message</td>
<td>47</td>
</tr>
<tr>
<td>Sender’s View of a Message with an Item Attached</td>
<td>48</td>
</tr>
<tr>
<td>Recipient’s View of a Message with an Item Attached</td>
<td>48</td>
</tr>
<tr>
<td>Options for Sending Individual Messages</td>
<td>49</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>49</td>
</tr>
<tr>
<td>Priority</td>
<td>49</td>
</tr>
<tr>
<td>Read Receipt</td>
<td>49</td>
</tr>
<tr>
<td>Delivery Receipt</td>
<td>49</td>
</tr>
<tr>
<td>Delayed Delivery</td>
<td>49</td>
</tr>
<tr>
<td>Using Priority (Importance) Settings and Sensitivity Settings</td>
<td>50</td>
</tr>
<tr>
<td>Viewing a Message Sent with Sensitivity</td>
<td>51</td>
</tr>
<tr>
<td>Viewing a Message Sent With High Priority Setting</td>
<td>51</td>
</tr>
<tr>
<td>Read Receipts and Delivery Receipts</td>
<td>52</td>
</tr>
<tr>
<td>Automatically Generated Response to a Read receipt</td>
<td>53</td>
</tr>
</tbody>
</table>
Checking Status of Meeting Responses of a Meeting You Organized............................... 93
Checking Status of a Meeting Invitation That You Accepted........................................ 93
Revising Calendar Entries ................................................................................................. 94
Changing the Meeting Time for a Meeting You Organized............................................ 94
Editing an Existing Single Entry ...................................................................................... 94
Deleting an Existing Single Entry ..................................................................................... 94
Deleting a Single Occurrence of a Recurring Event ....................................................... 94
Deleting All Occurrences of a Recurring Event ............................................................... 94
Changing a Single Occurrence of a Recurring Event ..................................................... 95
Changing All Occurrences of a Recurring Event ............................................................. 95
Moving a Calendar Entry ................................................................................................... 95
Printing Calendar Entries .................................................................................................. 96
Calendar Preferences ........................................................................................................ 97
Week and Work Day Settings ......................................................................................... 97
Calendar Time Scale (Increments) .................................................................................. 97
Meeting Requests ........................................................................................................... 97
Free/Busy Time ................................................................................................................ 97
Reminders Settings ......................................................................................................... 98
Sound .............................................................................................................................. 98
Reminder Time Prior to Appointment ............................................................................. 98
Default Reminder Time for Tasks .................................................................................... 98
Sharing Calendars .......................................................................................................... 99
Granting Permission for Someone to View and/or Update Your Calendar .................... 99
Permission Level .............................................................................................................. 100
When finished with all selections, click on the OK button ............................................ 100
Alternate Method of Setting Permission Levels ............................................................ 101
Making Mailbox Folder Visible ....................................................................................... 102
Accessing Another Person’s Calendar ........................................................................... 103
Viewing the Other Person’s Calendar ............................................................................ 104
Creating a Shortcut Icon for Accessing Another Person’s Calendar .............................. 105
DELEGATE ACCESS ........................................................................................................ 106
Sending Messages on Behalf of Another Person ............................................................ 107
Requesting a Meeting on Behalf of Another Person ....................................................... 108
Inbox View ..................................................................................................................... 108
Opened Message View ................................................................................................... 108
TASKS .......................................................................................................................... 109
Task List .......................................................................................................................... 110
Tasks in Calendar View .................................................................................................... 111
Tasks vs. Calendar Entries ............................................................................................... 112
Tasks .............................................................................................................................. 112
Calendar Entries ............................................................................................................. 112
OWA Outlook Web Access ............................................................................................. 113
Signing On to OWA ........................................................................................................ 114
Important Note About Closing OWA Interface ............................................................. 114
OWA Inbox View ............................................................................................................ 115
Inbox Toolbar ................................................................................................................ 116
Sending a Message via OWA .......................................................................................... 117
Removing Names from the To: Field .............................................................................. 118
Including a File Attachment ......................................................................................... 119
Reading Messages in OWA .......................................................... 120
Update the Inbox View ................................................................. 120
Deleting Messages ........................................................................ 120
Displaying the Deleted Items Folder ........................................... 120
Emptying Deleted Items Folder .................................................... 120
OWA Calendar Toolbar ................................................................. 121
Display Calendar in OWA .............................................................. 121
OWA Contacts Toolbar ............................................................... 123
Using Contacts in OWA ............................................................... 124
Creating a New Contact in OWA .................................................. 125
Folders ......................................................................................... 126
Options ....................................................................................... 127
Changing the Password .............................................................. 128
Change Password Window .......................................................... 129
Forgotten Password ..................................................................... 130
Steps to Change Password if You’ve Forgotten Your Password .... 130
Closing OWA ............................................................................... 131

PUBLIC FOLDERS ........................................................................... 133
SCSU-Announce and SCSU-Discuss Folders ............................... 134
Displaying Number of Unread Messages from SCSU Listservs 135
Replying to a Message sent to the Listserv ................................. 136
Posting a Message to the Listserv .............................................. 136
Posting to the Folder Only .......................................................... 136

Some Notes about Outlook 2001 for the Mac ........................... 137
Retaining Original E-mail Address in Forwarded Messages ...... 137
Voting Buttons ........................................................................... 138
PDAs and Synching to Outlook .................................................. 138

Keyboard Shortcuts in Outlook .................................................. 139